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Preface 
 
This document describes the functions of the PC Historical Analysis module of the Fire Program 
Analysis (FPA) system.  Individuals from the USDA Forest Service, USDI Bureau of Land 
Management, USDI Bureau of Indian Affairs, USDI Fish and Wildlife Service, and USDI 
National Park Service participated in the development of FPA.  If you find errors, omissions, or 
items that need correction, please send your comments to the address below. 
 

USDA Forest Service 
National Systems Unit 

3833 S. Development Ave 
Boise, ID 83705 
(800) 253-5559 

 
To talk to someone at the Support desk with questions and/or comments regarding this site or 
any of the fire applications mentioned, call 800-253-5559 or email the Support desk at 
fire?/wo_nifc@fs.fed.us. 
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rlined text will designate the clicking of buttons or 
bs; i.e. Browse

Introduction 
Welcome to the PCHA software program.  The software has been developed to support the 
historical analysis process within the Fire Program Analysis system.  PCHA allows for the 
import of fire occurrence and daily weather observation data for a Fire Planning Unit (FPU) to 
support the generation of fire event scenarios.  Bighorn Information Systems developed PCHA 
under contract with the USDI Bureau of Land Management.  PCHA can accept all legacy PCHA 
database files.   
 
The fire occurrence and weather data records imported to PCHA reside in national corporate 
databases.  Forest Service fire occurrence records are stored in the National Interagency Fire 
Management Integrated database (NIFMID).  The U.S. Department of Interior agency fire 
occurrence records are stored in Boise, Idaho.  Weather data records are also stored in the 
NIFMID database.  Both data sets are available for downloading from the Internet. 
 
How This Users’ Guide Is Organized? 
The General Processing Flow chart that follows describes the process steps and provides some 
background material on external tasks required before starting PCHA runs. The other chapters 
describe what to do on each of the screens. The sections, with a few exceptions, have the same 
name as the commands on the PCHA menus.  
 
Conventions Used In This Users’ Guide Figure 1 
Bold text and arrows will designate selection of menu items.  
An example is: Fire => Edit Fires.  This notation directs the 
user to click on the Fire menu on the program taskbar and 
then to select the Edit Fires menu (Figure 1).  In addition, 
bold unde
ta . 

allation file, when finally released, can be downloaded from the Internet.  
he URL is as follows: 

ttp://www.fs.fed.us/fire/planning/nist/distribu.htm  

 a CD ROM from the National Helpdesk, which can be reached by 
alling (800) 253-5559.   

ntil that time, the PCHA software installation file can be downloaded from: 

ttp://www.fs.fed.us/fire/nfmas-beta/ 
 

 
Program Availability 
The PCHA software inst
T
 
h
 
It will also be available on
c
 
U
 
h
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Program Installation 
The following text describes the tasks necessary to install PCHA on a personal computer. 
 
Minimum System Requirements 
Before program installation, verify that the computer meets the following minimum system 
requirements: 
 
Table 1 – Minimum System Requirements 

Item Required Recommended 
Operating System Windows 95 or higher Same 
CPU 80386 Pentium 
Monitor Resolution 800 x 600 Same 
RAM 4 MB 256 MB 
Available Memory on the Hard Drive 5 Gigibits Same 
Mouse Yes Same 

Printer Any configured for use with the 
operating system Color 

 
Program Download Instructions from the NFMAS Beta Site 
 
Step 1 
Open Internet Explorer or any web browser.   
 
Step 2 
Navigate to the URL below: 
 
http://www.fs.fed.us/fire/nfmas-beta/ 
 Figure 2 
Step 3 
Click on the PCHA link.  The screen in 
Figure 2 will be displayed. 
 
Step 4 
Click  Save on the screen shown in Figure 
2. 
 
Step 5 
Navigate to the folder on the computer 
where the PCHA installation file titled 
SetupPCHA.exe is to be saved. Be sure to 
write down this file location.   Click  Save.
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Program Download Instructions from the NFMAS Distribution Site 
 
Step 1 
Open Internet Explorer on any web browser.   
 
Step 2 
Navigate to the URL below: 
 
http://www.fs.fed.us/fire/planning/nist/distribu.htm 
 
Step 3 
Scroll down the page to software, NFMAS modules. Double-click on PCHA_Version 1.2. link 
where X is the current version. 
 
Step 4 
On the next screen, double click on the PCHA_Version 1.2.X Download File link. 
 
Step 5 
Double-click on the PCHASetup.exe link. The screen in Figure 2 will be displayed. 
 
Step 6 
Click Save on the screen shown in Figure 2. 
 
Step 7 
Navigate to the folder on the computer where the PCHA installation file titled SetupPCHA.exe is 
to be saved. Be sure to write down this file location.   Click  Save. 
 
Installation Instructions 
The setup program installs the programs and support files required to run PCHA. The installation 
must be performed within the Windows environment. 
 
Step 1 
Program installation on most agency computers requires the user to have Administrator 
privileges.  If necessary, have a user with Administrator privileges log onto the computer to 
perform the program installation.  It is recommended the user have read and write permission for 
the folder into which PCHA is to be installed. 
 
Step 2 
Start Windows Explorer. 
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Step 3 
If the SetupPCHA.exe file has been downloaded from the Internet, navigate to the folder where it 
was saved.   
 
If the distribution CD ROM is being used, place the CD ROM in the CD ROM drive and 
navigate to the location of the SetupPCHA.exe file. 
 
Step 4 
Double-click on PCHA_install.exe.  Install Shield will unpack PCHA.  The user will be 
prompted throughout the following boxes: 
 
The Welcome box will open.  Click Next to continue setup. 
 
The user will be prompted to accept the default location of: 
 
 c:\fsapps\fsprod\fam\nfmas\pcha 
 
If desired, change this to another location by clicking on the Browse button. Click Next to accept 
the default or click Browse to change the location. Once this activity has been completed, click 
Next to continue. 
 
The user will be prompted to select a program folder.  The default is FPA. To accept click Next, 
to change scroll through the list of available choices or enter a new choice, then click Next to 
continue. 
  
PCHA will install.  
 
Getting Started 
This documentation assumes the user knows how to use a mouse, open a menu, and choose a 
menu and dialog options. For those who need a refresher, the following brief review may help.  
 
Navigating in PCHA 
 
Using a Mouse 
Using the mouse to run PCHA is much faster than keyboard control, and is much more efficient. 
The mouse moves the “cursor” (usually an arrow) around the monitor screen. To select an item 
on the screen, click on it by pressing the left mouse button. The left mouse button is used in the 
PCHA program. In some cases, it is necessary to click the mouse button twice in rapid 
succession.  This action is called a double-click. 
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r 
ing the cursor with the right, left, up and down arrow keys.  Then press the ENTER key 

ce the desired menu item is highlighted.  If the ALT key is pressed by mistake, press the ESC 

e of the menu (Figure 4).   This 
dicates that there is a sub-menu with more choices. Clicking on the small arrow will open the 

s d to the menu item. 
  

use 

tons and some information show all 
e time above or below the tabs.  Click on the tab to display the information desired. For 

aily Obs. tab shows a daily weather observat

r to Figure 6.  The 
ursor is moved from one cell to another in a specific 

 TAB key. 

 
Menus 
The program taskbar across the top of 
PCHA screen contains menus (Figure 3). 
The planner can select a menu either by 
clicking on it with the mouse, or by using 
the keyboard.  To use the keyboard, press 
and release the ALT key. The planner will 
see the File menu item highlighted. Select the menu desired by pressing the highlighted letter o
by mov

Figure 3 – Main Menu on Program Taskbar 

on
key to exit from the menu. 
  
Some menu items have a right facing arrow on the right sid
in
ub-menu and give more choices relate

Figure 4 – Example of Sub-menus 

 
Screen Tabs 
Both the Edit Weather and Edit Fire screens 
folder tabs to display a portion of the information 
stored for those data groups (Figure 5). The 
command but

Figure 5 

th
example, the D ion. 
 
The Tab Key 
The TAB key moves the cursor from one field to 
another field on an Edit screen or a Dialog box. To 
move backwards, hold down the SHIFT key and press 
the TAB key.  For example, refe

Figure 6 

c
order by pressing the
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reens have Command Buttons such as OK
Command Buttons 
Many sc , Exit, or Save. Clicking on the command 

utton with the mouse will activate that command. If there is an underlined letter, the planner 
may also hold the ALT key down and press the underlined letter to activate the Command 
button. 

and Buttons 

b

 
Figure 7 – Comm

 
 
Use of Command Buttons 

tons are usable from any of the tabs to enter a new record or a search. All of these but
 
Save Button 
The Save button saves the information for the active date to the PCHA database.  Until this 

lear Button

button is clicked, any changes made in fields are not permanently saved to the PCHA database. 
 
C  
The Clear button resets all data fields to blank.  
 
Delete Button 
This button deletes the current record from the databa
displayed on the screen, this button will be light gra
 
Labels in Italics

se. If there are no records in the database or 
y and inoperative. 

 Figure 8 
On some screens, some labels for fields are in italic 

.  Fields designated this way 

lanner to search for a single wind 
eed value or wind speed values greater than or 

 

(slanted) text (Figure 8)
are searchable fields.  For example, the Wind Speed 
field allows the p
sp
less than a specific value. 
 
Begin Search Button 
Click Begin Search to find the first record in the database or the first record that meets defined 

arch criteria.  se
 
Search Criteria Button 
Click Search Criteria to clear the screen and define the fields that will control, which records 
you want to find in the database.  Fields with their names written in italic text are available for 
searches.  After the criteria are entered, click Begin Search.   
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or example, the planner can search for all observations with 
 Criteria

 
F
temperatures greater than 50. Click Search  , click in the 
Obs Temp field.  Enter the following >50 and then click Begin 
Search, (Figure 9). 
 
Searching can be done based on a range of values.  For example, to 
ind precipitation events between 2 inches and 10 inches, click 

ia 
f
Search Criter . Click in the Precipitation Amount field and enter 
>=2.0 and <=10.0. Click Begin Search. This search will find all weather observations that have
between 2 inches and 10 inches of precipitation for the day. 
 
First, Previous, Next, and Last Buttons

 

 
The First button displays the first record in the database or the search list. The Previous a
Next 

nd 
buttons display the record before or after the current record. The Last button displays the 

st record in the database or search list. These buttons show light gray if there are no records in 
r displayed on the screen. 

ind Button

la
the database o
 
F  

 CriteriaUnlike the Search  and Begin Search buttons, which retrieve a set of records to view, 
the Find button is used to jump to desired records within those already retrieved with Begin 
Search. Click Find and then select Clear 
fields.  Enter the value(s) to determine w

for Find from the pop-up menu.  This will clear all 
hich record is wanted, and then click Find and select 
m record to another similar record after a FindFind from the pop-up menu.  To move fro  

command, click Find and then select Find 
 
Exit Button

Next or Find Previous from the pop-up menu.  

 
The Exit button closes the screen and retu
 
Option Buttons 
Some screens have Radio Buttons (small 

rns the user to the main PCHA screen. 

ircles) where the planner can select one 
e group. When the planner 

ion has been 
elected.  The planner can select an option 

 on wording with the mouse.   

Figure 9 

Figure 10 - Option Box with Radio Buttons 

c
item from th
chooses one, a small black dot notes the 
selected option.  In the example in Figure 
10, the Delete ALL Fires opt
s
by clicking
The planner can also select an option by 
using the up and down arrows to highlight 
the desired Option.  Select that option by pressing the ENTER key.   
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hen the planner highlights a list box, the planner can 
umber in the list box.  In the 

Using Online Documentation and Help 
The PCHA release includes this documentation in electronic form to help guide the planner in its 
use.  In addition, there is extensive online help for nearly every field and command. Details on 
how to use the online help capabilities are provided.  Many parts of PCHA include context-
sensitive help.  Full online help may not be available for work needed to support Fire Program 
Assessment, FPA. 
 
Product Support 
Several groups and individuals support the PCHA software. Federal users should first contact 
their agency support personnel for assistance. Forest Service and other users should contact local 
and regional support personnel before contacting the National F&AM Application Helpdesk at: 
fire?/wo_nifc@fs.fed.us. 

Figure 11 – List Box List Boxes 
Some screens have List Boxes with a pulldown list.  
The planner can choose one item by clicking on it 
with the mouse (Figure 11). 
 
Shortcut 
W
press a valid letter or n
example in Figure 11, pressing a number from 0 to 7 
will cause the item to be highlighted.  Pressing the 
ENTER key will select the highlighted item. 
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General Process Flow 
The process used to complete an analysis in Fire Program Assessment (FPA) starts with the 
establishment of the FPU in FPA-PM.  Refer to the Users’ Guide for FPA-PM and the FPA-PM 
Reference Guide for instructions on this process. 
 
The purpose of Historical Analysis is the review and validation of fire occurrence and weather 
data for use in the creation of a fire event scenario.  A fire event is a single wildland fire 
measured in time from its estimated ignition time through its life until out.  A fire event is the 
collective sum of attributes that describe the statistical and physical characteristics of the fire.  
Grouping of fire events yields a fire event scenario. 
 
The creation of a fire event scenario is also done using PCHA.  Figure 12 shows the link between 
the FPA-PM program and the PCHA program.  The FPU is created in PCHA via the import of 
GIS shape files exported to the local computer by FPA-PM.  After a fire event scenario is created 
by PCHA, the fire planner imports the resulting file to FPA-PM. 
 
The process flow for tasks to be performed in PCHA is described via a stepwise process in Table 
2.  Provided in the table is the page number in this Users’ Guide where implementation details 
are provided for a step.  Also provided in the table is the page number in the FPA-PM Reference 
Guide where technical documentation and guidance is provided.  
 

Figure 12 – Process Flow Between FPA-PM and PCHA 
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Table 2 - Process Steps to Completion of Historic Analysis Using PCHA 

Step Description PCHA 
Menu 

Users’ 
Guide 
Page 

Reference 
Guide 
Page 

1 Install PCHA on the computer.    
1a Setting up PCHA start icon.    

2 In PCHA, Define the Planning Unit.    

2a Input data. File => Planning Unit 
Setup 

  

2b Import FMUs from FPA-PM. 
FPA => Import FPA-
PM Layer to Start New 
Analysis 

  

2c Edit FMU slope class. FPA => Edit FMU 
Slope Class 

  

3 Define weather stations, weather data 
sets and retrieve these records.    

3a 

For each FMU, determine if weather 
stations will be used to develop the 
weather data set for the FMU or if the 
GRID weather process will be used. 

 

  

3b 
For each FMU where weather stations 
will be used, determine the weather 
stations to use. 

 
  

3c 
For FMUs where GRID weather will be 
used, estimate the latitude and longitude 
for a point that will represent the FMU. 

 
  

3d Define the weather stations and GRID 
weather datasets in PCHA. 

File => Weather 
Stations 
 

  

3e 
For weather stations being used, retrieve 
from the corporate database all available 
weather records. 

 
  

3f 
For FMUs where GRID weather data 
sets will be used, retrieve the data set via 
the Internet. 

 
  

3g Import all weather records and weather 
datasets into PCHA. 

Weather => Import 
(Applicable Format) 

  

4 Retrieve Fire Report Records.    

4a Retrieve from the corporate database all 
available fire occurrence records.    

4b 

If necessary, transform an agency’s fire 
occurrence records into a format that 
can be used to import these fire 
occurrence records into PCHA. 
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Table 2 - Process Steps to Completion of Historic Analysis Using PCHA 

Step Description PCHA 
Menu 

Users’ 
Guide 
Page 

Reference 
Guide 
Page 

4c Import all fire records into PCHA. 

Fires => Import Fires 
=> (Applicable Sub-
menu)  
 

  

4d Implement Substitute Measures if Fire 
Records Are Not Available.    

5 Verify completeness and accuracy of 
weather records.    

5a Repair invalid observations. 
Weather => Repair 
Invalid Weather 
Observations 

  

5b Do queries to find obvious invalid. Weather => Edit 
Weather Observations 

  

6 Use weather records.    

6a Assign weather stations to FMUs. FPA => Assign Wx 
Stations to FMUs 

  

6b Create the weather data set for each 
FMU. 

FPA => Create FMU 
Weather Data Set 

  

6c Check for missing weather. FPA => View Missing 
Weather Report 

  

6d 
Implement additional weather data 
gathering processes if necessary.  If 
necessary, go to Step 3. 

 
  

6e 

If wildland fire use will be used in any 
FMU in the FPU, develop the waiting 
time distribution for the fire-ending 
event for each applicable FMU. 

FPA => Determine 
Waiting Time 
Distribution 

  

7 Verify completeness and accuracy of 
fire records.    

7a Check for possible duplicate fires. FPA => Report 
Possible Duplicate Fires

  

7b Assign latitude and longitude to fires 
where necessary.    

7b1 

Determine the appropriate latitude and 
longitude for the fire’s ignition location. 
Enter it manually into the fire’s record 
in PCHA. 

Use Fires => Edit Fires 
=> Location Tab. 
 

  

Or     
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Table 2 - Process Steps to Completion of Historic Analysis Using PCHA 

Step Description PCHA 
Menu 

Users’ 
Guide 
Page 

Reference 
Guide 
Page 

7b2 
Automatically, assign latitude and 
longitude from Township, Section, 
Range and Meridian.   

Fire => Calculate 
Lat/Lon from Legal 

  

7c Check for accuracy and completeness of 
required or recommended data fields.   

FPA => Fires Missing 
Data Required for FPA 

  

7d Edit fire records. Fire => Edit Fire 
Records 

  

8 Use fire occurrence records.    

8a Assign each historic fire that occurred 
during the analysis period to an FMU. 

FPA => Assign FMUs 
to Fires Using GIS 

  

8b Review FMU assignment results. FPA => View FMU 
Assignment Results 

  

8c For fires without an assigned FMU, 
make changes to the fire record.    

8c1 

If the latitude and longitude are 
incorrect, determine and enter the 
correct latitude and longitude.  Then 
repeat Step 6a. 

Fire => Edit Fires => 
Location Tab. 

  

Or     

8c2 Manually assign fires to an FMU. Fire => Edit Fires => 
FPA Tab 

  

8d Calculate and make edits if necessary to 
the each FMUs fire workload point. 

FPA => Calculate/Edit 
FMU Workload Point 

  

9 Locate and gather topographic grid files. FPA => Identify FMU 
ASCII Grid Files 

  

10 

(Optional – Complete this step or step 
12) use spatial fuel types for some or all 
FMUs by locating or generating fuel 
type grid files. 

 

  

10a Locate and make available fuel type grid 
files.    

Or     

10b Generate and make available fuel type 
grid files    

10c 
Identify to PCHA the directory and 
folder location for the fuel type grid 
files. 

FPA => Identify FMU 
ASCII Grid Files 

  

11 Collect FMU ASCII grid files into 
PCHA. 

FPA => Collect FMU 
ASCII Grid Information
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Table 2 - Process Steps to Completion of Historic Analysis Using PCHA 

Step Description PCHA 
Menu 

Users’ 
Guide 
Page 

Reference 
Guide 
Page 

12 

(Optional – Complete this step or step 
10) use non-spatial fuel types for some 
or all FMUs by developing fuel types 
for the FPU and assigning these the 
occurrence proportion for each fuel type 
to the applicable FMUs. 

 

  

12a Define all of the fuel types in the FPU. FPA => FPU Fuel 
Types 

  

12b 
For each FMU where non-spatial fuel 
types will be used, assign the percent of 
the FMU that exists in each fuel types. 

FPA => FMU Fuel 
Type Percents 
 

  

13 Calculate fire behavior, bins and fire 
probabilities. 

FPA => Calculate 
ERCg and Wind Speed 
Bins, Fire Probabilities 

  

14 Determine preparedness season. FPA => Determine 
Preparedness Season 

  

15 Prepare the fire event scenario.    

15a Prepare probability-based fire event 
scenario. 

FPA => Prepare 
Probability-based Fire 
Event Scenario and 
XML File for FPA 

  

Or     

15b Prepare historic-based fire event 
scenario. 

FPA => Prepare 
Historic-based Fire 
Event Scenario and 
XML File for FPA 

  

16 View FPA scenario details. FPA => View FPA 
Scenario Details 

  

17 Transfer XML file to FMA-PM.  Use 
FPA-PM to do this.    
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 The Exit menu item allows the 
lanner to quit the program (Figure 13). 

rogram is stored 
 a Microsoft Access© database.  The file extension for this 

 
uld 
.  

e Example is entered, the new 
atabase will have a file name of PCHA99Example.mdb.  Notice the program adds the PCHA 

ified. 

 databases is in the 
lder where the PCHA software is 

installed.  If the desired PCHA database is 
not located there, navigate to the folder 
where the database is located.  Click on the 
file so that it appears in the File name box 
at the bottom of the dialog screen and click 
Open

 
The File Menu Figure 13 – The File Menu 
The file menu allows the planner to create or open an 
existing PCHA database, to create and edit attributes of the 
FPU and to define and edit attributes for weather stations 
that will be used.  The planner can print a screen using the 
Print Screen menu items. 
p
 
The PCHA Database 
All data entered or imported via the PCHA p
in
database is mdb. 
 
New Database 
This menu item allows the planner to create
a new PCHA database.  This activity wo
be preformed when a new FPU is created
When this menu is selected, the dialog 
screen shown in Figure 14 appears.  As 
with all files, a name needs to be designated 
for this new database.  Enter that name in 
the box provided using only characters that 
are allowed in the Windows file naming convention.  The nam

Figure 14 

d
letters in front of the name spec
 
Open Existing Database 
This menu item allows the planner to open 
a currently defined PCHA database.  When 
this menu item is selected, the standard file 
open dialog as shown in Figure 15 is 
displayed.  The default location where 
PCHA looks for existing

Figure 15  

fo

.  When PCHA is started, the last 
active database is opened automatically.  
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Planning Unit Setup Figure 16 – The Planning 
Unit Setup Menu Before the planner can import weather and fire records, the 

planner must enter the Planning Unit Setup values, 
particularly the unit identification. Once these values are 
defined, the planner will not usually need to return to the 
Planning Unit Setup menu. 
 
Selecting the Planning Unit Setup screen will result in the 
display of a screen similar to the one shown in Figure 17. The 
last part of the screen in Figure 17 is used to select the fire 
planning process being used.  This controls the menu options 
made available.  Select FPA. 
 
Unit Name 
Enter the FPU name.  This is an optional but highly recommended entry. 
 
Agency 
Click anywhere in the highlighted box and select the agency group that best describes the 
agencies participating in the FPU.  If more than one agency is participating, select Interagency.  
 

Figure 17 – The Planning Unit Setup Screen 
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Preparedness Staffing Season 
Enter the beginning date (e.g. 4/15) and ending date (e.g. 11/15) for the analysis. 
 
Analysis Years 
Enter the beginning and ending years for the analysis. Data can be imported beyond the analysis 
years, but most reports only show fires within the analysis period.  Fire occurrence records may 
contain fires from 1970 to 1995, but if the analysis period is from 1986 to 1993 then only fires 
from 1986 through 1993 will be used.   
 
Enter the beginning year (e.g. 1984) and the ending year (e.g. 2003) to define the analysis period. 
 
Latitude 
Enter the average latitude for the FPU as an integer. 
 
UTM Zone for GIS 
Enter the UTM Zone for the FPU. 
 
The Highlight Color Button 
The default light color (the color shown in the box where entries are made) is yellow. To change 
this color from the default, click on Highlight Color.  Select the color desired from the 48 basic 
colors or create a custom color. 
 
Weather Stations 
Selecting File => Weather Stations the screen shown in 
Figure 19.  Figure 19 shown an example of data to be entered 
for each weather station identified for use in the analysis.  
PCHA requires all data fields be completed.  Each weather 
station must be defined before weather observations for a 
weather data set can be imported.  One source for most of the 
information is the WIMS station catalog available at 
http://famweb.nwcg.gov/weatherfirecd/. 
 
Search Button 
Click Search to find the first weather station record in the 
database. Once weather station is displayed, the planner can 
use First, Previous, Next, and Last to move through the stations. The planner can also search 
for a particular weather station. 

Figure 18 – The Weather 
Stations Menu 

 
Station ID 
Enter the six-digit weather station identifier. The station identifier can contain both numbers and 
letters.   
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Station Name 

nter  statio ters). This entry is o nal b
he station name but not the station number. 

 N-U.  Table 
a listing of the NFDRS fuel models. 

Figure 19 – Screen to Define Weather Stations Attributes 

 

E
M

the n name (up to 12 charac ptio ut strongly recommended. 
any people know t

 
Fuel Model 
Enter the NFDRS fuel model to use for this station. Valid entries are letters A-L and
3 contains 
 
Table 3 – NFDRS Fuel Models 
Fuel Model Description Fuel Model Description 

A Western annual grass K Light logging slash 
B California mixed chaparral L Western perennial grass 
C Pine grass savannah N Sawgrass 
D Southern rough O High pocosin 
E Hardwoods (winter) P Southern pine plantation 
F Intermediate brush Q Alaska black spruce 
G Closed short needle conifer (heavy) R Hardwoods (summer) 
H Closed short needle conifer (light) S Alaska tundra 
I Heavy logging slash T Sagebrush grass 
J Medium logging slash U Western long needle conifer 
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es) 
er calculations. Daylight 

iation on the fuels.  

ue affects the calculation 
om the weather  

heck the box if the 1988 version of NFDRS is to be used.   Required 
al inputs include the starting greenness factor for both 

lt Keetch-Byram Drought 
dex (KBDI), the average annual precipitation, the starting 1000-h 

sture and designation of the
).  Checkin option will enable

s.  S e calculated values will 
S tab.  This x sh

vaila . 

escribes the rainfall regime in the FMU 
presented by the weather station 

ate class defines var
al, and 

e adapted to v ous moisture regimes and respond differently to 
infall.  Those adapted to moist environments lose moisture faster than those from dry 

environments.  Plants growing in drier climates typically respond more quickly to rainfall events. 
Choose the appropriate climate class that represents how local plants respond to rainfall events. 
 
 
Slope Position 
Choose the slope position that 
best describes the location of the 
weather station (Table 5). 
 

Figure 20 

Latitude (Degre
Enter the latitude in degrees for the station. This value affects fire dang
length changes with latitude and season, which affects solar rad
 
Elevation 
Enter the elevation in feet above mean sea level of the station. This val
of the fire behavior indices when PCHA adjusts the fire behavior indices fr
station to the fire location. 
  
Use 88 NFDRS 
C
addition
herbaceous and woody vegetation, the defau
In
timelag fuel moi  live woody vegetation as 
deciduous or evergreen (Figure 20
use of 1988 NFDRS models in calculation
show for each day in the '88 NFDR
unchecked unless all the required data is a
 
Aspect 
Select the aspect the weather station is on.  
 
Climate Class 
Select the climate class that best 

g this  the 
om
 bo ould remain 
ble

Table 4 – Climate Class Definitions 
Code Definition 

d
re
(Table 4).  Clim iable 
drying rates for annual, perenni
woody plants within the live fuel 
moisture model.  Plants hav ari

1 Arid, semiarid. 
2 Subhumid (rainfall deficient in summer) 
3 Subhumid (rainfall adeq asons) uate in all se
4 Wet 

Table 5 – Slope Position Definitions 
Alpha Code Numeric Code Description 

L 1 Flat to Lower 1/3rd of slope 
M 2 Middle 1/3rd of slope 
U 3 Upper 1/3rd of slope 

ra
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Slope Class Table 6 – Slope Class Definitions 

Code Definition Slope Used 
1 0 – 25% 22.5% 
2 26 – 40% 31.8% 
3 41 – 55% 44.5% 
4 56 – 75% 66.3% 
5 75%+ 90.0% 

Enter the slope class that best describes the slope 
class where this weather station is located (Table 6). 
Percent slope is the rate of elevation gain or loss in 
feet per 100 feet horizontal distance. Slope classes 
include a range of slopes as defined below. 
 
Herbaceous 
Select the option for either annual or perennial that best represents the herbaceous vegetation in 
the FMU represented by this weather station. 
 
Start Date 
Enter the date herbaceous vegetation typically greens-up, and the date herbaceous vegetation 
freezes in a typical year for the FMU represented by this weather station. Entries must be month 
and date numbers separated by a slash or period. 
 
Print Button 
Print tells the computer to generate a page that looks like the weather station screen. This is a 
nice way to document entries and allows someone else to check the data. 
 
Exit Button 
Exit closes the Weather Station entry screen and returns to the main PCHA screen. 
 
Print Screen 
This command allows the printing of any screen for documentation purposes (Figure 21). 
  
 
Exit 
The Exit menu closes all PCHA files and screens and returns control to the Windows program 
manager (Figure 22). 
 
Figure 21 – The Print Screen Menu Figure 22 – The Exit Menu 
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us database.  In addition, weather observations 
ken at a National Oceanographic and Atmospheric 

btaining .FWX Weather Observation Records 
eral sources are available. 

 NFDRS Weather Station Observation Records 
Weather records from a NFD e FAMWEB Internet site at 
the URL: 

http://famweb.nwcg.gov/weatherfirecd/ 
Figure 24 

The Weather Menu 
The functions on this menu are available when selecting Weather from the main menu. The 
planner can import, edit, and export weather observation records and GRID weather data sets. 
The planner can also edit weather observation fields, enter Keetch-Byram Drought Index (KBDI) 
starting values, repair certain problems on observations and calculate National Fire Danger 
Rating System values. 
  
Import Weather Figure 23 – The Weather Menu
Importing weather data into PCHA for review, editing, and 
use as part of the fire planning effort is a powerful tool. This 
release allows the importing of ASCII weather observation 
or data set files in fwx or fw9 format.  Options also exist for 
importing the weather station attributes and weather 
observation records from another PCHA database or a 
FireFamily Pl
ta
Administration (NOAA) can be imported (Figure 23).  
 
O
The fire planner must obtain weather observation records.  Sev
 
Obtaining

RS weather station are available from th
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formation) and weather data sets.  The time period that weather data is available varies by 
tion.  The years available are noted in the last column on the Internet site (Figure 25). 

 
i ure 25 

Select the state and then weather stations from which the weather observations will be 
downloaded.  These files, on the Internet site, include station catalog attributes (NFDRS catalog 
in
weather sta

F g

 
When downloading a *.fwx, the user 
should right click on File => Save Target 
As in Windows Explorer (Figure 26). 
 
Navigate to the folder the file will be 
downloaded to using Windows Explorer.  
Be sure to note this folder location. 
 
Obtaining GRID Weather Data 
Records  
Reserved.  To be completed at a later date. 
 
 
 
 

Figure 26 
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ave the first two characters of the 

extension must be fwx (Figure 29).  
 
GRID weather files should be 
named using this convention.  It is 
recommended the six-character 
“station name” be related to the 
FMU name it is being assigned to. 

 
Import .FWX Weather Observations Figure 27  
The weather records for each weather station must be in 
separate files (one file per station).  
 
 
 
 
 
 
 
 
Before these weather observations can be imported to 
PCHA, the weather station attributes must defined using the 
File => Weather Stations menu (Figure 28).  See the 
description of this menu item for details.  

Figure 28  

 
 
 
 
 
 
 
 
The ASCII file naming convention 
requires that the last six characters 
of the file name to be the weather 
station identifier.  Weather 
observation files downloaded from 
the FAMWEB Internet site will 

Figure 29  

h
file name WX and the file 
extension will be fwx.  The file 
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When the planner selects Weather => Import .FWX Weather Observations, a dialog box 
similar to the one in Figure 29 appears.  It will be necessary to navigate to the folder where the 
weather observation files have been saved.  Once there, the dialog will list files with the .fwx 
extension.   The planner can either double click on the file name, or click once to highlight the 
file name and then click OK. 
 
The screen in Figure 30 will appear.  The planner must 
choose one of the three options listed on the screen. 

Figure 30  

 
Delete Existing Values For THIS Station 
The default option deletes all weather records for this 
station that currently exist in PCHA. Use this option to 
delete all existing records from the database and import a 
new weather data set. 
 
Overwrite Redundant Values 
This option imports new weather observations and replaces a weather observation in the PCHA 
database by a new observation if one exists in the ASCII weather observation file.   
 
Don't Overwrite (Skip Redundant) 
This option does not delete duplicate observations so it is possible for there to be more than one 
weather observation for the same day.  Use this option to add new records to the database, but 
keep all the existing records without changing them.  
 
After an option is selected, click OK to start the import process.  A progress bar will appear 
along the bottom of the screen. There is another Cancel button in case one wishes to stop the 
import part way through the process. 
 
Importing from a PCHA Database Figure 31  
All weather station attributes and weather observation 
records that exist in a PCHA database can be imported to a 
new PCHA database.  This option would be of value if 
weather observations had been imported and verified in a 
past planning effort that used PCHA. 
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Selecting Weather => Import 
PCHA Weather Observations 
will result in the screen in Figure 
32 appearing.  Clicking Browse 
will result in the screen in Figure 
33 appearing.   

Figure 32  

 Figure 33  
It will be necessary to navigate to 
the folder where the PCHA 
database file has been saved.  Once 
there, the dialog will list files with 
the .mdb extension.   The planner 
can either double-click on the file 

ame, or click once to highlight the 
le name and then click OK

n
fi .  The 

reen in Figure 34 will appear. sc
 
 
 
 
 
 
 
Notice the path to the file is shown.  
If the correct file has been selected, 

Figure 34  

click IMPORT.  Be aware that all 
eather stations and weather 

PORT

w
observations in the PCHA database 
selected will be imported once the  
IM  button is clicked.   

hen all weather station attributes and weather records have been 
ported, PCHA will display the screen in Figure 35. 

 
 
 
 

 
W Figure 35  
im
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Importing from a FireFamily Plus Database  Figure 36  
All weather station attributes and weather observation 
records that exist in a FireFamily Plus database can be 
imported to a new PCHA database.  This option would be of 
value if weather observations had been imported and 
verified in a past planning effort that used FireFamily Plus. 
 
 
 
 
Selecting Weather => Import 
FFPLUS Weather Observations 
will result in the screen shown in 
Figure 37.  Clicking Browse will 

Figure 37  

result in the screen shown in Figure 

d.  
 

n 

 file name and then 
lick OK

38.   
 
It will be necessary to navigate to 
the folder where the FireFamily 
Plus database file has been save
Once there, the dialog will list files
with the .mdb extension.   The 
planner can either double-click o
the file name, or click once to 
highlight the

Figure 38  

c  .  The screen in Figure 39 
ill appear. 

tions and weather 
bservations in the FireFamily Plus 

database selected will be imported once the IMPORT button is clicked.  When all weather station 
attributes and weather records have been imported, PCHA will display the screen in Figure 35. 
 

w
 
 
 
 
 
 
 
Notice the path to the file is shown.  
If the correct file has been selected, 
click IMPORT.  Be aware that all 
weather sta

Figure 39  

o
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s can be added to fill gaps. Selecting 
e Weather => Edit Weather Observations menu will 

result in th
 

Figure 42 – Edit Weather Observations Screen 

Importing NOAA Weather Observation Figure 40  
Reserved.  To be completed at a later date. 
 
 
 
 
 
 
 
 
 
Edit Weather Observations 
After importing the weather data, it needs to be checked for 
errors and missing observations. Some observations may be 
incomplete or there may be significant gaps in the weather 
observations. Data fields in individual weather records can 
be edited.  If a data field in a weather record is an estimated 
field value, be sure to check the User-Estimated Weather 
box.  Weather record
th

e screen in Figure 42 being displayed. 

 

Figure 41 
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Displaying a Weather Records for a Station   
Use the Station pull-down to select a weather station.  Do a left mouse click on the Clear button 
followed by a left mouse click on the Begin Search button.  A screen similar to the one shown in 
Figure 43 will be displayed. 
 

Figure 43 – Daily Weather Tab 

 
 
Top of Weather Screen 
The station number and observation date are always visible so the planner knows which weather 
station and observation date are displayed. 
 
Station ID 
This field shows the weather station or GRID weather data set identifier.  This field is searchable 
for specific records or groups of records as described under the Search Criteria button. 
 
Observation Date 
This field is the date of the weather observation. A planner can search for observations on 
specific dates or a range of dates in searches as described under the Search Criteria button. 
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Daily Observations Tab (Daily Obs) 
The screen in Figure 43 shows the content of the Daily Observation tab on the Edit Weather 
Observations screen.  The fields on this tab contain the values for each variable for the 
observation date.  The definitions of the fields are as follows: 
 
State of Weather Table 7 – State of Weather 

Definitions 
Code Definition 

1 Scattered clouds 
2 Broken clouds 
3 Overcast 
4 Foggy 
5 Drizzling 
6 Raining 
7 Snow or sleet 
8 Showering 
9 Thunderstorms in progress

State of Weather indicates the amount of cloud cover, kind 
of precipitation, and/or restrictions to visibility at the 
weather station at the observation time.  Table 7 shows the 
State of Weather definitions. 
 
 
 
 
 
 
 
 
Wind Direction Table 8 – Wind Direction 

Definitions 
Code Definition 

0 --- Calm 
1 NE Northeast 
2 E East 
3 SE Southeast 
4 S South 
5 SW Southwest 
6 W West 
7 NW Northwest 
8 N North 

This field shows the direction from which the wind blew at 
the observation time coded into one of 8 directions.  Table 
8 shows the wind direction definitions. 
 
Wind Speed 
Wind speed in miles per hour is a 10-minute average 
measured at 20-feet above the average height of the 
vegetative cover. 
 
10h Timelag Fuel Moisture (10-Hour FM) 
This is the moisture content of the 0.26 – 1.00 inch dead 
and down fuels.  Frequently, it is measured by weighing 
calibrated fuel sticks. 
 
Temperature (Temp) 
This field is the dry bulb temperature measured in degrees Fahrenheit. 
 
Relative Humidity (RH) 
Relative humidity, expressed as a percent, is the proportion of amount of water in the air to the 
amount of water at saturation given the same temperature and barometric pressure. 
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Precipitation 
Precipitation is expressed both in the amount and the duration. 
 
Precipitation Duration 
Precipitation duration is the time expressed in hours that measurable precipitation events lasted 
during the previous 24-hour period.   
 
Precipitation Amount 
Precipitation amount is the amount of atmospheric moisture that reached the ground within the 
previous 24-hour period.  
 
User-Estimated Weather 
If the planner enters an estimated value for any field in the weather record for the observation 
date, check this box. 
 
1988 NFDRS Tab 
The data on the NFDRS tab shows the additional data required to support the 1988 version of 
NFDRS (Figure 44). 
 

Figure 44 – ’88 NFDRS Tab 
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Season 
This field identifies one of the four seasons of the year. Options are Unknown, Winter, Spring, 
Summer or Fall. 
 
Woody Moisture 
This is the moisture content of woody (shrub) fuels. Values can range up to 250 percent. 
 
Woody Date 
This field is the observation date of the woody fuel moisture. 
  
Greenness 
This is the greenness factor from 0 through 20 that indicates the relative level of shrub greenness. 
Zero indicates that all leaves have fallen off deciduous shrubs or that evergreen shrubs are 
dormant. Twenty indicates fully developed shrub leaves that are not under moisture stress. Use 
intermediate values during spring greenup, fall curing, or during drought conditions. 
 
There are separate entries for herbaceous greenness and shrub greenness. 
 
Calculated Values Tab 
The data on this tab shows the calculated values for the national fire danger rating system based 
on the weather observation. The calculations use the 1978 NFDRS formulas unless the Use 88 
NFDRS box on the weather station definition screen  was checked (Figure 45). 
 

Figure 45 – ’88 NFDRS Tab 
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1-h Timelag Fuel Moisture (1-h TH FM) 
Observation time, relative humidity, and temperature measured at 4.5-feet above the ground are 
the weather values used to calculate the 1-h timelag fuel moisture. Observed weather values are 
adjusted from a 4.5-foot observation to an estimated condition at ground level using factors 
determined by the State of Weather codes. 
 
10-h Timelag Fuel Moisture (10-h TH FM) 
The preferred method to obtain the 10-h timelag fuel moisture is to weigh fuel moisture sticks at 
the weather station.  When fuel sticks are not measured, the 10-h timelag fuel moisture is 
estimated in a manner similar to that for the 1-h timelag fuel moisture. 
  
100-h Timelag Fuel Moisture (100-h TH FM) 
The 100-h timelag fuel moisture is determined from the weather observation values of 
precipitation duration, maximum and minimum temperature and relative humidity. The 
maximum and minimum values are for the 24-hour period that begins at observation time 
yesterday (in relation to the weather record date) and ending at observation time today. 
 
1000-h Timelag Fuel Moisture (1000-h TH FM) 
The 1,000-hour timelag fuel moisture calculation uses the same basic methodology as the 100-
hour timelag fuel moisture but bases calculations on conditions over a seven-day (168 hours) 
period. 
 
X1000 Value (X1000) 
The X1000 value limits the increase in herbaceous fuel moisture due to precipitation. The 1,000-
hour timelag fuel moisture controls the drying rate of herbaceous fuel moisture and the X1000 
value controls the rate of increase of herbaceous fuel moisture content due to precipitation. 
 
Herbaceous Fuel Moisture (Herb FM) 
Plants that do not develop persistent woody tissues such as grasses, forbs and ferns are live 
herbaceous fuels. These fuels are further subdivided into annual and perennial vegetation types. 
The herb fuel moisture is estimated using National Fire Danger Rating System (NFDRS) 
calculations. When the fuel moisture falls below 30 percent, these plants are considered cured 
and the moisture content defaults to that of the 1-h timelag fuels. 
 
Woody Fuel Moisture (Woody FM) 
Plants that develop persistent woody tissue such as shrubs are live woody fuels. These fuels are 
considered dormant when the moisture content falls to 50 percent.  Maximum moisture content 
during the growing season is 250 percent.   
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Percent Green (% Green) 
The 1988 NFDRS requires users to enter greenness factors that express actual greening and 
curing of both live herbaceous and live woody vegetation. Greenness factors represent a visual 
estimate of the current general greenness of herbs and grasses, and shrubs, compared with their 
maximum greenness. The greenness factors range from 0 to 20. Zero (0) represents fully dried 
herbaceous plants or dormant shrubs, and 20 represents a condition in which the herbs and/or 
shrubs are as green as they can ever get. 
  
Herbaceous Stage (Herb Stage) 
There are four herbaceous stages in the live moisture fuel model.  These stages are cured, 
greenup, green and transition.  Each stage is utilized in the model to determine fuel load transfer 
from live herbaceous to dead 1-hour timelag fuel moisture. The affect on live fuels is as follows: 
 
Cured 
All live herbaceous fuel loading is transferred to 1-hour timelag fuel category (1-h TL FL). 
 
Greenup 
During this stage, the herbaceous fuel load that is 100% in the 1-h timelag dead category is 
transferred back to the live herbaceous category as the live fuel moisture.  When the live fuel 
moisture reaches 125 percent, the entire herbaceous fuel load is in the live herbaceous category. 
 
Green 
All herbaceous fuel loading is in the live herbaceous category. 
 
Transition  
During transition, live fuel load is progressively transferred from the live category to the 1-h 
timelag fuel load category as the live herbaceous fuel moisture moves from 125% to 30%. 
 
Spread Component (SC) 
The Spread Component is an index calculated in a manner very similar to the calculation of the 
rate of spread in the Fire Behavior Prediction System.  It is expressed in feet per minute and is 
calculated using the NFDRS fuel model attribute of the weather station.   
 
Energy Release Component (ERC) 
This value is based on the estimated potential available energy released per unit area in the 
flaming zone of the fire. The ERC is dependent on the same fuel characteristics as the Spread 
Component. The day-to-day variations of the ERC are caused by changes in the moisture 
contents of the various fuel classes including the 1,000-hour timelag fuel moisture class. The 
ERC is derived from predictions of the rate of heat release per unit area during flaming 
combustion and the duration of flaming. 
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Burning Index (BI) 
The Burning Index is derived from the Spread Component and Energy Release Component. The 
rate of fire spread and the energy released in the flaming zone, considered together, are the 
means of rating the difficulty of containment. The BI is linearly related to the length of flames at 
the head of the fire.  
 
Fire Intensity Level (FIL) Table 9 – FIL Definitions 

FIL Flame Length 
1 0 – 2.0 feet 
2 2.1 – 4.0 foot 
3 4.1 – 6.0 feet 
4 6.1 – 8.0 feet 
5 8.1 – 12.0 feet 
6 12.1+ feet 

The Fire Intensity Level is a measure of fire intensity as it 
influences fire effects (rather than fire behavior) and is represented 
by flame length. The six FIL categories and their associated flame 
lengths are listed in Table 9. 
 
Bottom of Edit Weather Screen 
All of these buttons are usable from any of the tabs to enter a new 
record or a search. 
 

Figure 46  

 
 
Save Button 
The Save button saves the information for the active date to the PCHA database.  Until this 
button is clicked, any changes made in fields are not permanently saved to the PCHA database. 
 
Clear Button 
The Clear button resets all data field to blank.  
 
Delete Button 
This button deletes the current record from the database. If there are no weather observation 
records in the database or displayed on the screen, this button will be light gray and inoperative. 
 
Begin Search Button 
Click  Begin Search to find the first weather observation record in the database or the first 
record that meets the defined search criteria.  
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Search Criteria Button 
Click Search Criteria to clear the screen and define the fields that will control which weather 
observation records to find in the database.  Fields with their names written in italic text are 
available for searches.  Station ID, observation date, precipitation, wind speed, precipitation 
amount, observed temperature, and observed relative humidity are search fields.  After the 
criteria are entered, click Begin Search.   
 
For example, a planner can search for all observations with temperatures 
greater than 50. Click Search Criteria then click in the Obs Temp field.  
Enter the critarion >50 and click Begin Search. 
 
To find precipitation events between 2 inches and 10 inches, click Search 
Criteria . Click in the Precipitation Amount field and enter >=2.0 and 
<=10.0. Click Begin Search. This search will find all weather observations that have between 2
inche

Figure 47  

 
s and 10 inches of precipitation for the day. 

 
First, Previous, Next, and Last Buttons 
The First button displays the first weather observation record in the database or the search list. 
The Previous and Next buttons display the weather observation before or after the current 
observation. The Last button displays the last observation in the database or search list. These 
buttons show light gray if there are no weather observation records in the database or displayed 
on the screen. 
 
Find Button 
Unlike the Search Criteria and Begin Search buttons, which retrieve a set of records for 
viewing, the Find button is used to jump to desired records within those already retrieved with 
Begin Search. Click Find and then select Clear from the pop-up menu.  This will clear all 
fields.  Enter the values to determine which record is desired, then click Find and select Find 
from the pop-up menu.  To move from record to another similar record after a Find command, 
click Find and then select Next or Previous from the pop-up menu.  
 
Exit Button 
The Exit button closes the weather observation edit screen and returns to the main PCHA screen. 
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Repair Invalid Observations 
This function will review all the weather records and correct 
weather records that have certain incorrect information. A 
box will pop up and will ask for confirmation of whether to 
proceed.  The status bar across the bottom shows progress 
through the weather records. 
 
After PCHA finishes the repairs, a display box will pop up 
with the message "xxx invalid weather observations were 
written to file INVWX.DAT." The INVWX.DAT is a text 
file saved in the folder where PCHA is installed. The report 
can be viewed by clicking OK .  Clicking on Print will print the report.  

Figure 48 

 
The planner can scroll through the report by moving the scroll bars on the right and bottom. The 
report lists station number, observation date, field name affected, original value, new value, and 
a description of the problem. 
 
Errors corrected include: 
 

• Maximum humidity less than yesterday or today's observed relative humidity. Maximum 
relative humidity is set to the greater of yesterday or today's relative humidity. 

 
• Minimum humidity greater than yesterday's or today's observed relative humidity. 

Minimum relative humidity is set to the lesser of yesterday or today's relative humidity. 
 
• Maximum temperature is less than yesterday or today's observed temperature. Maximum 

temperature is set to the greater of yesterday or today's temperature. 
 
• Minimum temperature is greater than yesterday or today's observed temperature. 

Minimum temperature is set to the lesser of yesterday or today's temperature. 
 
• Maximum relative humidity is less than minimum relative humidity. Maximum and 

minimum relative humidity values are swapped. 
 
• Maximum temperature is less than Minimum temperature. Maximum and minimum 

values are swapped. 
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nge, and file type for each export.   

ar to the one shown in Figure 
0 to be displayed. 

atabase. Choose the station desired to export.  

 

e 

observation date falls between the two 
ates. 

xport Type 

 
Export Weather Observations Figure 49  
The menu item allows the planner to export in either fwx or 
fw9 format weather records.  Each weather station needs to 
be exported separately. Choose the station number, date 
ra
 
 
 
 
 
 
Selecting Weather => Export Weather will 
cause a screen simil

Figure 50  

5
 
Station ID 
PCHA will list the stations defined in the 
d
 
Dates 
Enter the beginning and ending dates to export in
the From and Through boxes. Enter the dates in 
mm/dd/yyyy format. PCHA will export only th
weather observations for the requested station 
whose 
d
 
E
 
FWX (Short observation) 
This is the same format as the PCHA import file format. 
 
FW9 (WXOBS98) 
This is the Y2K compliant format. 
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igure 52.  

weather 

HA 

 
 

er 

gh 

 
Purge Weather Observations Figure 51  
This option will remove selected sets of previously 
imported weather observations.  Selecting the Weather => 
Purge Weather Observations produces the screen in 
F
 
 
 
 
 
 
 
The user can select one or more 
stations and a range of weather 
observations to be deleted from the PC
database.  The From Date is the first 
weather observation (month, day and year)
that is to be deleted and the Through Date
(month, day and year) is the last weath
observation that is to be deleted.  All 
weather observations for the selected 
station(s) between the From and Throu
Dates will be deleted when the Purge 

Figure 52  

button is selected.  The From and Through date range format is mm/dd/yyyy. 
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ange and Section). Reports help to find problems in the data, and clean data can be 
ported for further use. 

he fire planner must obtain fire occurrence records.  Several sources are available. 

ervice and the National Park Service 
re available from the FAMWEB Internet site at the URL: 

 
http://famweb.nwcg.gov/weatherfirecd/ 

Figure 54 

 
The Fire Menu Figure 53 – The Fire Menu 
This menu item provides functions available to manage fire 
data. Import Fires loads fire data into the PCHA database. 
Edit Fires allows the planner to verify and modify fields in 
a fire occurrence record.  A utility exists to calculate the 
latitude and the longitude for a fire from the legal location 
(Township, R
ex
  
Obtaining Fire Occurrence Records 
T
 
Obtaining Federal Agency Fire Occurrence Records from the Internet 
Historic fire occurrence records for the USDA Forest Service and the USDI Bureau of Land 
Management, Bureau of Indian Affairs, Fish and Wildlife S
a
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elect the state and then agency.  These 
ire 

ccurrence for each agency’s corporate 

 
vailable are noted on the Internet site. 

ata 
 

. 

s location. 

d in 

U that have entered fire occurrence data into 
the NFIRS fire report database system.  The U. S. Fire Administration, an agency in FEMA, has 
developed this fire report system.  Information about the wildland fire report module of NFIRS 
(NFIRS-8) is available at www.nfirs.fema.gov

 
S
files, on the Internet site, include f
o
fire occurrence database.  The time period 
that fire occurrence records are available 
varies by organizational unit.  The years
a
 
 
 
 
 
 
When downloading a fire occurrence d
file, the user should right click on File =>
Save Target As in Windows Explorer
 
Using Windows Explorer, navigate to the 
folder the file will be downloaded to.  Be 
sure to note this folder’
 
Obtaining Other Agency Fire 
Occurrence Records 
For other agencies participating in an 
analysis, consult with that agency’s fire 
planning personnel for availability of 
historic fire occurrence records.  Import of 
these records is possible if the records are 
available in an ASCII file format support for import to PCHA.  These formats are discusse
the following section. 
 
There may be some agencies participating in the FP

.  The National Fire Information Council (NFIC) 
has developed NFIRS under contract from the U. S. Fire Administration.  Information about the 
NFIC can be found at www.nfic.org.  There may be an import menu selection built into PCHA 
for NFIRS fire report data at some future date.  Any existing NFIRS fire occurrence data can be 
imported into PCHA using the PCHA Standard Fire Import Format process.  The NFIRS 
wildland fire report module has only been operational for a few years.  There may be some 
Eastern or Midwest state agencies, local fire departments, rural or volunteer fire departments that 
may have some fire occurrence data in NFIRS.      

Figure 55 

Figure 56 
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Required File Naming Convention 

 
Import Fires 
To import fire occurrence records to PCHA, select Fire => Import Fires.  The fire occurrence 
records must be in one of the formats shown in Table 10.  The required file name and extension 
for each file format is also shown in Table 10. 
 
Figure 57 

Table 10  
ormats File F

PCHA Standard Fire Import Format *.PCHAFIRES 
Forest Service PCHA Format *.RAW 
DI-1202 Format *.fpl 
Update Existing Records with DI-1202 Control 
Date, Init Date and FT/PT 

*.fpl 

Oregon Department of Forestry Fire ODF*.FIRES 
PCHA Transfer Format *.mdb 
Import Fires from Another PCHA Database PCHA*.mdb 

 
Description of File Formats 
A description of each of the fire occurrence file formats. 
 
PCHA Standard Fire Import Format 

tates and local agencies may also be participating in the analysis process.  Each agency will S
have its own fire report format and historic data may exist in an electronic format.  PCHA cannot 
support all the possible import formats.  It is recommended that the planner work with these 
agencies to create an ASCII file with the data from the fire occurrence records.  This ASCII file 
should be in the PCHA Standard Fire Import Format.  Table 11 contains a description of the 
fields in the comma-delimited ASCII PCHA standard file format.  The ASCII file must have a 
*.PCHAFIRES file extension. 
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Table 11 – PCHA Standard Import Format File Definition 

 
Field 

ID 

Required 
For 

Import 

Needed 
For 
FPA 

Type Width Example Use 

1 X X Integer 4 2004 Discovery Year 
2 X X Integer 2 12 Discovery Month 
3 X X Integer 2 30 Discovery Day 
4  X Integer 4 1552 Discovery Time 
5   Text 20 “HORSE THIEF #2” Fire Name 
6 X  Text 6 B072 Fire Number 
7   Text 2 SW Region Identifier 
8   Text 3 13A Unit Identifier 
9   Text 2 CA State 
10  X Integer 1 6 Statistical Cause Code 
11  X Integer 2 44 North Latitude Degrees 
12  X Integer 2 58 North Latitude Minutes 
13  X Real 2.4 21.8901 North Latitude Seconds 
14  X Integer 2 119 West Longitude Degrees
15  X Integer 2 28 West Longitude Minutes
16  X Real 2.4 14.7992 West Longitude Seconds
17  X Integer 4 2004 Control Year 
18  X Integer 2 12 Control Month 
19  X Integer 2 30 Control Day 
20   Integer 4 1942 Control Time 
21  X Integer 2 20 Slope Percent 
22  X Integer 6 5914 Elevation (Feet) 
23   Text 1 G NFDRS Fuel Model 
24   Real 8.2 6129.25 Total Acres Burned 
25   Text 240 “Report By John” Remarks 

 
An example row from the comma-delimited ASC file in the Standard PCHA Fire Format is 
shown in Figure 58.  Notice that fields 5 and 26 contain spaces in the example entries. As such 
the data in these fields is contained in quotation marks. 
 
Figure 58 – Example of a Fire Record in the Standard PCHA Fire Format 
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The statistical fire cause and the aspect codes to be used in fields 10 and 33 are shown in Tables 
12 and Table 13.  

 
Table 12 – Statistical Fire Causes  Table 13 – Aspect Codes 

Code Cause  Code Aspect 
1 Lightning  0 Flat 
2 Equipment Use  1 North 
3 Smoking  2 Northeast 
4 Campfire  3 East 
5 Debris Burning  4 Southeast 
6 Railroad  5 South 
7 Arson  6 Southwest 
8 Children  7 West 
9 Miscellaneous  8 Northwest 
   9 Ridgetop 

 
Forest Service PCHA Format 
Forest Service PCHA data files use the naming convention PCHArrff.RAW where rr is the 
region and ff is the forest number. The first four characters must be PCHA and the file extension 
must be RAW. For example, the input file for the Angeles NF in Region 5 would be 
PCHA0501.RAW. 
 
Some fields contain data that is valid in the agency database, but is not valid in PCHA. One item 
in particular--NFDRS fuel model--may contain fuel model “X” in Forest Service data, but PCHA 
converts fuel model 'X' to a blank during the import process.  The format for the Forest Service 
PCHA file is contained in the Appendix. 
 
DI-1202 Format 
The DI-1202 data files use the naming convention *.fpl where the * represents any series of legal 
file naming characters.   
 
Update Existing Records with DI-1202 Control Date, Fire Type / Protection Type 
Department of Interior (DOI) fire records may have been imported to a legacy PCHA database 
using the BLM and BIA import formats.  These formats did not include import of the control 
date or fire type/protection type.  This menu allows for updating of the DOI fire report records 
after they have been imported using the Import Fires From Another PCHA Database menu 
option. 
 
Oregon Department of Forestry Fire 
The Oregon Department of Forestry (ODF) data files use the naming convention ODF*.FIRES 
where the * represents any series of legal file naming characters.   
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Import Fires From Another PCHA Database 
PCHA database files are Microsoft Access® database files (*.mdb) and use the naming 
convention PCHA99*.mdb where * represents any series of legal file naming characters.   
 
Importing Fire Occurrence Files into PCHA 
To import fire occurrence records to PCHA, select Fire => Import Fires.  Then select the 
format of the import file.  For all file formats except the PCHA Transfer Format, the standard 
Windows Explorer file selection dialog will appear.  The planner needs to navigate to the folder 
where the import file exists, to select the file and then click Open. 
 

Figure 59 – Fires Import 
Option Screen 

Next, a dialog box similar to the one in Figure 59 appears.   
The planner must choose one of the three options listed on 
the screen. 
 
Delete ALL Fires 
The default option deletes all fire records that currently 
exist in PCHA. Use this option to delete all existing records 
from the database and import a new fire record data set. 
 
Overwrite Redundant Values 
This option imports new fire records and replaces a fire record in the PCHA database with a new 
ecord if one exists in the ASCII fire record file.   r

 
Don't Overwrite (Skip Redundant) 
This option does not delete duplicate observations so it is possible to have more than one fire 
record for the same day.  Use this option to add new records to the database, but keep all the 
xisting records without changing them.  e

 
After an option is selected, click OK to start the import process.  A progress bar will appear 
along the bottom of the screen. There is another Cancel button in case one wishes to stop the 

port part way through the process. 

he 
 fields need to be examined for 

ompleteness and errors. 

ation calculated or 
ssigned by PCHA and fields that are manually assigned by the fire planner.  

 

im
 
Edit Fires 
Now that fire occurrence records have been imported for t
FPU, the records and data
c
 
Figure 61 shows the seven tabs on the screen that appear 
when the Fire => Edit Fires is selected.  The tabs contain 
fields with information contained in the historic fire record, fields with inform

Figure  60 – The Edit Fires 
Menu 

a
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Each tab except the Misc tab displays a group of related data items.  The Misc tab shows data 
fields that did not fit well elsewhere. Some agencies have procedures to let the planner send 
corrections back to the corporate agency fire records database so future data extracts will have 
the benefit of the corrections made. 
 

 
Look closely at the fire records to ensure they accurately reflect the planning unit's fire history.  
Are any large fires missing?   If so, find the reports and add them to the planning database. Also 
contact local agency support personnel for instructions on how to add the missing fire(s) to the 
corporate database. 

Figure  61 – The Edit Fires Menu 

 
Are there any fire records included in the database that should be excluded?  Delete those 
selected from the PCHA database that should not be part of the historical base for planning. 
Examples of fires to exclude are fire associated with activities that are unlikely to recur. A series 

f small fires at a rock concert, slash fires associao ted with timber harvest where timber harvest 
ay 

s to 

ould be of value to the planner to verify the 
cc pecifically used in the processes to 

develop fire event scenarios.  The planner should be sure these data fields are complete and 
acc on of the electronic data to the hard copy fire report may be needed.  

equired information from the fire report for each historic fire to be used for the probability-
based fire event scenario process includes: 
 

• Fire Type/Protection Type code for DOI agency fires 
• Fire location 
• Discovery date 

 

no longer occurs or rail equipment-caused fires along a now abandoned railroad right of w
may fit this criteria. 
  
If interagency partners exist in the FPU, a historic fire that each of the agencies reported need

e identified.  To begin this process, use the FPA => Report Possible Duplicate Fires menu to b
generate a report of fires with similar attributes. 
 

ire report records contain many fields.  It wF
a uracy of all of these data fields.  Several data fields are s

urate.  A comparis
 
R
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Some information from the fire report for each historic fire is used to develop frequency 
distributions.  Random draws from these distributions are used in the probability-based fire event 
scenario generation process.  Frequency distributions are developed for: 

 
• Discovery time 
• Fire control date 
• Statistical cause 

 
There needs to be an adequate number of fires with values for these fields so the frequency 
distributions can be developed. 

 
Additional information from the fire report for each historic fire to be used for the historic-based 
fire event scenario process includes: 
 

• Aspect 
• Slope or slope class 
• Elevation or elevation class 
• Surface fuel model (used to assist in fuel type assignment) 

 
Top of Fire Screen 
The four fields on the top portion of the screen are visible regardless of which tab is selected 
(Figure 61). 
 
Fire Name 
The fire name is an optional but a very useful entry field. This is a searchable field allowing the 
planner to search the database for a specific fire by name.  If fire names are added, do not include 
the word “Fire” as part of the name. 
 
Fire Number 
The fire number can be up to six characters long.  The fire number and discovery date give each 
fire record a unique identity. 
  
Discovery Date 
This field is the date the fire was discovered.  If a missing historic fire is added, the planner must 
define the date of discovery. Enter all dates as mm/dd/yyyy . 
 
Discovery Time 
This field is the time the fire was discovered.  All times are shown in military time.  Note that the 
Forest Service fire discovery time ranges from 0000 (midnight) to 2359. BLM, BIA, NPS and 
FWS units have a fire discovery time that ranges from 0001 to 2400 (midnight). PCHA does not 
accept times outside those ranges. 
 
Events Tab 
The screen in Figure 62 will appear when selecting Fires => Edit Fires => Events tab.  This tab 
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displays events recorded for the fire. Note that discovery date shows on the top portion of the 
screen.  Not all events are necessarily known for any given fire.  Events with no data will be 
blank.  DOI agency fires, generally only include discovery date and time in the imported data. 
Few (if any) Forest Service fires include Report, Dispatch, Declared Wildfire, or Contained 
events at this time.  Events that are used by PCHA to support development of fire event scenarios 
should be examined for completeness and accuracy.  Consult paper copies of fire records when 
necessary to verify or obtain event data.  It is recommended that data should only be entered into 
blank data fields if the entered data can be verified to be accurate.  
 
Figure 62   

 
Each event has a date and associated time. Enter dates in month, day, year format (i.e., 
6/15/1995) and time in hours and minutes in military time format (i.e., 1425). 
 
Fire Ignition 
This event is the best estimate of the date and time the fire ignited.  If the date and time are not 
known for certain (which is often the case), this should be the best estimate of the date and time. 
 
Report 
The report field records the date and time when the reporting suppression agency learned about 
the fire.  
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Dispatch 
This field is the date and time when the first fire preparedness unit was dispatched to the fire.  
 
First Action 
This field is the date and time that initial suppression action began at the site of the fire. This 
time must be at least one minute after discovery. 
 
The first action for a prescribed natural fire might be an aerial reconnaissance flight, or a 
determination by management on the type and kind of fire suppression or management activities. 
 
Second Action 
This field is the date and time that reinforcements arrived at the fire site.  This field records when 
the first reinforcements arrived.  These units must arrive at least 5 minutes after the initial 
resource(s) arrived. 
 
Declared Wildfire 
This field is the date and time when a fire manager declared that a prescribed fire would be 
suppressed as a wildfire. This is applicable regardless of whether the ignition was from natural 
sources such as lightning or from a resource management decision to ignite the fire. Agency 
policy dictates the circumstances for the change in status. There are various management reasons 
this declaration or change in status may occur. Leave this field blank if the fire was not a 
prescribed fire at some point in its life. 
 
Contained 
This field is the date and time when the fire was declared contained.  
 
Controlled 
This is the date and time when the fire was declared controlled.  Other terms used include 
Suppression Strategy Attained or Suppression Strategy Met. This would also be the date and 
time when the strategy was met for a prescribed natural fire. 
 
Fire Out 
This is the date and time when the fire was declared out. At least one minute must elapse 
between the control date and time and fire out time. 
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Location Tab 
The screen in Figure 63 will appear when selecting Fires => Edit Fires => Locations tab.  This 
tab displays the data recorded for the administrative and geographical locations of the fire.  
 
Figure 63 –  

 
Region/State Office 

eld is the two-digit Forest Service Region number or is the two-letter State Office code for This fi
DOI agencies. Other agencies should leave this field blank. 
 
Unit ID 
This field is the three-letter fire unit designator. These identifiers must be unique within a state. 
  
Unit Number 
This field is one of the following: two-digit Forest Service National Forest number, the BLM 
District identifier, the BIA Agency identifier, the NPS park identifier or the FWS refuge 
identifier. 
 
Ranger District/Resource Area 
This field is the two-digit Ranger District number within a National Forest or the Resource Area 
within a BLM District or BIA Agency.  It will be blank for the NPS and FWS. 
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Wilderness 
A three-digit wilderness code uniquely 
Congress in which the fire bega
boundaries after the congressional declar
occur in a designated wilderness, leav
 
State

defin et aside by 
n. By defini ly fires that occ rness 

ati co s. If the fire did not 
e this an

es the wilderness area designated and s
tion, on urred within wilde
on are nsidered wilderness fire
field bl k or zero. 

 
The two-letter postal abbreviation identifies ate the st  in which the fire started. 
 
County 
This three-digit county code identifies the
by a Federal Information Processing Syste
 

 c n defined 
m ) 

otection Agency

ounty i which the fire started. The codes are 
 (FIPS publication.  

Pr  

rivate, or other protection agencies, use 
d two-letter state codes. 

This field identifies the agency legally 
responsible to provide primary 
protection for the land on which the fire 
started. For federal agencies, use the 
three-letter codes below. For state, local, 
p
the standar
 
Latitude and Longitude 
The latitude and longitude values locate 

int of origin. Report degrees, the fire’s po
minutes, and seconds in whole numbers. 
  
Legal Location (Meridian, Township, Range, Section, Subsection) 
For fires in the 30 public land survey system states, enter township, range, section, subsection, 
nd principal meridian to locate the fire’s origin. The legal description should correspond very 

to the geographical coordinates (latitude and longitude). Fires in areas not covered by the 
a
closely 
public land survey system should leave all these fields blank. 
 
Meridian 
The meridian field has a list of all the principal meridians defined in the US. Use the pull-down 

 select the principal meridian. to
 
Township 

nter the township number and direction (N or S from the baseline). If a township is entered 
rection (N or S), an error message will not appear.  If the township is a special 

ncy Codes Table 14 – Protection Age
Codes Federal Agency 
USF USDA Forest Service 
BLM USDI Bureau of Land Management 
BIA USDI Bureau of Indian Affairs 
FWS USDI Fish and Wildlife Service 
NPS USDI National Park Service 
ARM Department of Defense - Army 
AFS Department of Defense – Air Force 
NAV Department of Defense – Navy 
OTH Other Federal Agency 

E
without a di
township (such as a quarter, half, or three-quarter township), change the value in the box to the 
right of township to show that fact. 
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Range 
Enter the range number and direction (E or W from the principal meridian). If a range is entere
without a direction (W or

d 
 E), an error message will not appear.  If the range is a special range 

such as a quarter, half, or three-quarter range), change the value in the box to the right of range 

ction

(
to show that fact. 
 
Se  

 from 1 to 36. Enter a section number
 
Subsection 
The subsection can be shown to the nearest quarter se on
40 acres). By convention, enter the smallest subdivis  fi eans the 

southwest quarter of the southeast quarter section. 
 
FMZ

cti
ion

 (160 acres) or quarter quarter section 
rst. As an example, SWSE m(

 
If a Fire Management Zone has been entered on the fi rep d here. This 
field is not used in FPA. 
 
Representative Location (RL) 
This field is not used in FPA.  Leave it blank. 
  
Ownership at Origin 
Only Forest Service units use this field. It shows 
the one-digit code that corresponds to land 
ownership at the point of origin (Table 15). 
 

Table 15 – Ownership at Origin Codes 
Code Definition 

1 National Forest, National Grassland, 
or Land Utilization Project. 

2 State and private lands inside Forest 
Service protection boundary. 

3 Lands outside Forest Service 
protection boundary. 

4 Other Federal lands inside Forest 
Service protection boundary. 

re ort, it will be displaye
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Cause Tab 
The screen in Figure 64 will appear when selecting Fires => Edit Fires => Cause tab.  This tab 
displays the fire cause codes for each fire. In addition, check boxes show whether the fire was an 
escaped fire and/or a prescribed fire (blanks mean no).  For most fire planning purposes, 
statistical cause is very important, and the other cause codes further define the actual cause. 
Prevention planning relies heavily upon accurate fire causes. 
   
Figure 64  

 
Report Cause 
This is an optional use field that allows for entry of a brief description of the fire’s cause. This is 
a particularly useful field if the other fire causes do not adequately describe the actual fire cause. 
Many fires do not fit easily into the current fire cause coding system and this field allows for a 
better description of what really caused the fire. 
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Statistical (Cause) 
Table 16 – Statistical Cause Codes 

Code Dept. of 
Interior 

Forest 
Service 

0 Not specified N/A 
1 Natural Lightning 
2 Campfire Equipment use 
3 Smoking Smoking 
4 Debris burning Campfire 
5 Incendiary Debris burning 
6 Equipment use Railroad 
7 Railroad Arson 
8 Children Children 
9 Miscellaneous Miscellaneous 

This field identifies the broad statistical cause for 
the fire. Note that the code numbers are different 
between Forest Service and DOI-1202 codes, but 
the definitions are the same. PCHA translates 
from the external agency codes to the internal 
codes. PCHA internally uses the Forest Service 
statistical cause codes (Table 16). 
 
General (Cause) 
General cause supplements statistical cause to 
better identify the human activity associated with 
the fire ignition. The list box shows the available 
categories. Code unknown activities and lightning 
fires into the Other category. 
 
Specific (Cause) 
Specific cause attempts to narrow down the exact fire cause. Group unknown causes into the 
Other category. 
 
People (Class) 
This field identifies the group or class of people associated with the fire ignition. Code lightning 
fires as Other. Code persons whose status cannot be determined as Other. 
 
Prescribed Fire (Check Box) 
If someone with authority decided to manage an unplanned ignition as a prescribed fire, then 
check the box. If the ignition was suppressed as a wildfire, leave the box unchecked. 
 
Escaped Fire (Check Box) 
If the planned first action and first reinforcement forces achieved the suppression strategy for the 
fire, then leave the box unchecked. If the fire escaped fire suppression efforts of the planned 
response, check the box. 
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Size/Topo Tab 
The screen in Figure 64 will appear when selecting Fires => Edit Fires => Size/Topo tab.  This 
tab displays the size and topographic attributes for each fire.  Total acres must be entered for 
each fire. 
 
Figure 64  

 
 
Total Acres Burned 
This field shows the total acres burned regardless of ownership. Code fires that burn less than an 
acre to the nearest 0.1 acres. Code fires that are larger than 1 acre in whole acres. If the data 
includes only size class, most size class “A” fires are less than 0.1 acre, enter 0.1 as the total 
acres for those fires. This is a required field for every fire. 
 
Agency Acres 
This is the number of acres that burned on the reporting agency’s land. 
 
Other Protection Acres 
Enter the acres of non-agency lands protected by the agency within the fire perimeter. 
 
Other Acres 
Enter the acres outside the agency’s protection boundary within the fire perimeter.  
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Size Class

Table 17 – Size Class 
Definitions 
Code Definition (Acres) 

A 0.0 – 0.24 
B 0.25 – 9.9 
C 10.0 – 99.9 
D 100 – 299 
E 300 – 999 
F 1000 – 4999 
G 5000+ 

This one-letter code categorizes fires into size classes. Size class 
is based on the total acres burned, not just the area burned within 
the planning unit.  Fires before 1970 only used codes A-E with E 
defined as 300 acres and larger. If fires that occurred before 1970 
are entered, use the more recent codes.  The definition of each 
size class is contained in Table 17. 
 
Elevation 
This is the elevation of the fire.  It is entered to the nearest 
hundred feel. 
 
BLM Elevation Code 
This field is the elevation class at the fire head during the initial attack. 
 
Aspect 
This field is the general aspect (direction the land faces) on which the fire was burning at the 
time of initial attack. 
 
Slope Percent 
This field is the percent slope at the fire origin. 
 
Slope Description 
This is an optional entry field to briefly describe the slope and topographic position of the fire 
(i.e., lower, middle, upper, ridgetop and so forth). 
 
Slope (BLM) 
This field is the slope code at the fire origin used on BLM and BIA fires.  
 
Vegetation Cover 
This two-digit code identifies the general cover type in which the fire burned during the initial 
attack. Each Forest Service Region has defined the important cover types within the region and 
assigned a two-digit numerical code to each. 
 
One complication to the coding scheme is that most Forest Service Regions change the definition 
of their codes about every decade. That means that a particular code on a 1970 fire may not mean 
the same as the same code in 1995. Generally the Regional codes identify both cover type and 
the conditions within a vegetation type that are significant to fire protection activities. Examples 
include cutover, seedling and saplings, bug-killed pole stands, thinning slash, and so forth. 
  
If the planner intends to rely heavily upon this data, the planner should obtain a copy of the 
applicable vegetation cover class codes for the period in the analysis so the codes can be 
interpreted correctly. 
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Topography 
This field defines the general topography within the fire’s burned area. 
 
PCHA Tab 
The PCHA screen displays the current values of selected fire information contained in the fire 
report, generated from GIS maps, calculated by PCHA, or entered manually. Only manual fields 
on this screen may have values entered. 
 
 All of the fields on this screen except rate of spread (ROS) contain values that come from 
agency fire reports (Report cell).  If a fire report record was imported to PCHA from another 
PCHA database used to do fire planning using the legacy system, then there might be an entry 
for a field in the GIS or Manual cells. 
 
 
  
Figure 66 

 
 



 

PCHA 1.2 Users’ Guide – 10/18/2004 - Draft Page 57

FMZ 
This field displays the current Fire Management Zone (FMZ) information on the fire contained 
in the fire report, calculated from GIS maps, or entered manually.  The FMZ provided by the fire 
report will be from a legacy planning system and has no application in FPA.   
 
Representative Location 
This field displays the representative locations assigned to fires calculated from GIS maps or 
entered manually.  This field is not used in FPA. 
 
Weather Station 
This field displays the station number and observation date that could be used for the fire based 
on data from the fire report, assigned by the program, or entered manually.  The Station Date 
field displays the date of weather assigned to the fire. Weather date could be different from the 
actual fire date due to missing weather data or other factors driven by the assignment priorities. 
 
NFDRS Fuel Model Table 18 – NFDRS Fuel Models 

Fuel 
Group NFDRS Fuel Model 

A – Western Annual Grasses 
C – Open Pine with Grass 
L – Western Perennial Grasses 
N – Sawgrass 
S – Tundra 

Grass 

T – Sage with Grass 
B – Mature Brush (6 feet) 
D – Southern Rough 
F – Intermediate Brush 
O – High Pocosin 

Brush 

Q – Alaska Black Spruce 
E – Hardwood Litter (Fall) 
G – Heavy Short Needle Timber Litter 
H – Normal Short Needle Timber Litter 
P – Southern Lone Needle Pine Litter 
R – Hardwood Litter – Spring/Summer 

Timber 
Litter 

U – Western Long Needle Litter 
I – Heavy Slash 
J – Medium Slash Slash 
K – Light Slash 

This field shows the National Fire 
Danger Rating System (NFDRS) 
fuel models assigned to the fire 
based on data from the fire report, 
generated from GIS maps, or 
entered manually. Check the 
Annual box if the herbaceous 
vegetation is annual.  Leave it 
unchecked if perennial. 
 
Fire Intensity Level 
This field displays the fire intensity 
levels assigned to the fire based on 
the fire report, calculated by the 
program or entered manually.  
 
Rate of Spread (ROS) 
This field shows the calculated rate 
of spread in chains (66 feet) per 
hour. 
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Misc Tab 
This tab (Figure 67) shows fire data that did not easily fit anywhere else, but that some planners 
wish to keep and use. 
 
Fire Account 
This field shows the fire cost account code. If this value is entered, enter the five-digit "P" code 
value assigned to the fire without the leading “P” or “R.” A “P” code is now required for all 
Forest Service D class (100 acres) and larger fires, but is recommended for all fires if the data is 
available. 
 
Suppression Strategy 

Table 19 – Suppression 
Strategy Codes 
Code Strategy 

1 Confine 
2 Contain 
3 Control 

This field is a Forest Service code that identifies the predominant 
strategy for the kind, amount, and timing of the initial dispatch 
and initial suppression action. 
  
 

Figure 67 
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n CostSuppressio  
This field stores the estimated total emergency fire fighting funds expended by the protection 
agency as a result of this fire. 
 
Map on File 
Check this box if a map is attached to the report or if a map is on file. This can serve as a 
reminder that more detailed location and perimeter information is available locally. 
 
Remarks 
Enter remarks that you may have.  
 
FPA Tab 
This tab contains cells specific to FPA. 
 
Figure 68 

 



 

 Page 60                                                                                                                     PCHA User’s Guide – 10/18/2004 

Manual FMU Assignment 
This entry allows for the planner to manually assign an FMU for a historic fire.  This may be 
needed if one is not assigned via the FPA => Assign FMUs to Fires Using GIS menu.  If a fire 
is assigned incorrectly to an FMU, it is because the latitude/longitude assigned to the fire is not 
within the FMU.  Instead of changing the FMU assignment here, edit the incorrect latitude 
and/or longitude assignment and then select FPA => Assign FMUs to Fires Using GIS. 
 
GIS FMU Assignment 
This is the FMU assigned to the fire via the FPA => Assign FMUs to Fires Using GIS menu. 
 
DI-1202 Fire Type / Protection Type 
Two fields, fire type and protection type, identify the types of incidents.  Table 20 provides 
definitions for each. 
 
Table 20 – DOI Fire Type and Protection Type Definitions 

Fire Types Protection Types 
Code Description Code Description 

1 Suppressed Fire 1 For agency land under agency protection. The agency has 
the fire suppression responsibility. 

2 Natural Out 2 For agency lands protected by another Federal agency 
under an interagency mutual aid agreement. Another 
agency does the suppression work. 

3 Support Action 3 For agency lands protected by a non-Federal agency (e.g. 
state, county, city) under a cooperative agreement, memo of 
understanding, or contract. 

4 Prescribed Fire 4 For fires suppressed under confine or contain strategy under 
Fire Type 1. 

5 False Alarm 5 For other lands not under agreement, memo of 
understanding or contract, but where agency suppression 
action was taken to prevent fire spread onto agency lands; 
i.e. private land adjacent to agency boundary. 

6 For other lands protected by agency under a memo of 
understanding, interagency agreement or contract. 

7 Support actions by agency resources under Fire Type 3. 
8 Prescribed burns – management-ignited prescribed fires, 

ignited by or for park management under Fire Type 4. 

 

9 Prescribed natural fires - ignited by lightning, volcanic 
activity, or other natural ignition sources under Fire Type 4. 
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PCHA for FPA Should Exclude This Duplicate Fire 
Within an FPU, there can be multiple agency partners that historically have responded to the 
same fires.  Each agency might have completed an agency fire report for one or more of these 
fires.  When all of these agencies’ fires are imported to PCHA, duplicate fire reports can exist for 
the same historic fire.  This check box allows for the designation of a fire as a duplicate fire. 
 
The identification of potential duplicate fires is possible using the FPA => Report Possible 
Duplicate Fires menu.  This menu item produces a report of fires with similar fire report values. 
 
Fuel Type for Historic-based Scenario 
A fuel type in FPA is a unique combination of the following: 
 

• Canopy cover 
• Surface (FBPS) fuel model 
• Canopy base height 
• Canopy bulk density 
• Stand height 

 
Canopy cover 
Canopy cover is normally measured as a percent.  It is based on the lineal length that is within a 
canopy versus in the open.  
 
Surface (FBPS) fuel model 
These are the 13 FBPS fuel models 
(Anderson 1982). 
 
Canopy base height 
For an individual tree, the measurement 
of the height to the base of the crown 
can be made.  The averaging of these 
values for all trees in a stand would give 
an estimate of the height of the canopy 
base height.  Frequently, this is a 
measure of where the limbs of the 
canopy start vertically.  This number 
can be skewed by the presence of small 
trees or occasional live limbs.  A more 
meaningful value would be the height 
above the ground of the first canopy layer where the density of the crown mass within the layer 
is high enough to support vertical movement of a fire.  

Table 21 FBPS Fuel Models 
Fuel Group FBPS Fuel Model 

1 - Short Grass (1 foot) 
2 - Timber (Grass and understory) Grass 
3 - Tall Grass (2.5 feet) 
4 – Chaparral 
5 – Brush 
6 - Dormant Brush Brush 

7 - Southern Rough 
8 - Closed Timber Litter 
9 - Hardwood (pine long needle litter)Timber 

Litter 10 - Timber 
11 - Light Slash 
12 - Medium Slash Slash 
13 - Heavy Slash 

 



 

 Page 62                                                                                                                     PCHA User’s Guide – 10/18/2004 

Canopy bulk density 
Mathematically, canopy bulk density (CBD) (lbs/ft3) is canopy biomass divided by the volume 
occupied by canopy fuels.  Canopy bulk density is hard to estimate in the field.  Initially, it 
seems attractive to calculate this value by treating the canopy as a box with the depth of the stand 
height minus the canopy base height.  Assuming this box covered an acre (43,560 ft2), dividing 
the fuel loading in the canopy by the volume of box would provide an estimate of average 
canopy bulk density.  Unfortunately, this estimate has a bias toward under estimation of the 
canopy bulk density due to the averaging of largely void areas in the top and bottom of the 
canopy with the more dense layers of foliage.  A fire burning vertically within the crowns will 
most likely propagate through denser canopy layers. 
 
Stand height 
For an individual tree, height is the measurement to the top of the tree tip.  Averaging the heights 
for all trees in a stand would give an estimate of the stand height.  
 
This pull-down allows for the designation of a fuel type that existed at the point of origin of a 
historic fire.  If a surface fuel model (FBPS or NFDRS) is designated on the fire report, that 
information should be used to determine an appropriate fuel type. 
 
Bottom of Edit Fires Screen 
All of these buttons are usable from any of the tabs or to enter a new record or a search. 
 

Figure 68 

 
ave ButtonS  

The Save button saves the information for the active date to the PCHA database.  Until this 
not permanently saved to the PCHA database. button is clicked, any changes made in fields are 

 
Clear Button 
The Clear button resets all data fields to blank.  
 

elete ButtonD  
This button deletes the current record from the database. If there are no fire report records in the 
database or displayed on the screen, this button will be light gray and inoperative. 
 

egin Search ButtonB  
Click Begin Search to find the first fire report record in the database or the first record that 
meets the defined search criteria.  
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Search Criteria Button 
Click Search Criteria  to clear the screen and define the fields 
records you want to find in the database.  Fields with their names written in italic text are 
available for searches.  After the cr

that will control which fire report 

iteria are entered, click Begin Search.   

 fires with a statistical 
 
For example, the planner can search for all
cause of campfire.  To do so, click Search Criteria , go to the 
Cause tab and select Campfire from the Statistical (Cause) pull-
down.  Then click Begin Search. 
 
First, Previous, Next, and Last Buttons 
The First button displays the first fire report record in the database or the search list. The 
Previous and Next buttons display the fire reports before or after the current one. The Last 
button displays the last fire report in the database or search list. These buttons show light gray
there are no fire report  records in the database or displayed on the screen. 
 
Find Button

 if 

 
Unlike the Search Criteria and Begin Search buttons, which retrieve a set of records to view, 

e Find button is used to jump to desired records within those already retrieved with Begin th
Search. Click Find and then select Clear from the pop-up menu.  This will clear all fields.  
Enter the values to determine which record is desired, and then click Find and select Find from 

e pop-up menu.  To move from a record to another similar record after a Findth  command, click 
Find  and then select Next or Previous from the pop-up menu.  
 
Exit Button 
The Exit button closes the fire report edit screen and returns to the main PCHA screen. 
 

Figure 70 
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only works for public land survey states, and 
ly if the conversion factors exist for the area the FPU is in. 

s the 

 unit maps, or other 
urces to manually assign latitude and longitude values in some situations. 

 
e dialog shown in Figure 72. 

lly Entered 

ne. If the 
xisting latitude and longitude values are accurate, then do not select this option. 

 

Calculate Latitude and Longitude from Legal Locations 
Figure 71 – The Edit Fires 
Menu 

For some planning activities, latitude and longitude 
coordinate values are very useful. Latitude and longitude 
are required so GIS tools can assign each historic fire to a 
FMU.  Some fire records only have legal description 
locations (township, range, and section). To get latitude and 
longitude on each fire, the planner can edit each fire record.  
A utility can also be run that will calculate latitude and 
longitude values from legal locations. This process 
on
  
This menu item calculates latitude and longitude values at the center of the section.  Since in 
most cases, PCHA only knows the township, range, and section number, the section center i
point of least error. The convert routine generates some errors when assigning latitude and 
longitude values from legal descriptions (township, range, and section), particularly in areas with 
half townships. Therefore, it is wise for the planner to use topographic maps,
so
 
Selecting the Fire => Calculate 
Lat/Lon for Legal menu yields

Figure 72 

th
  
Overwrite Manua
Lat/Long Values 
Check this box to replace the 
existing latitude and longitude 
values already entered into the 
database with the new latitude and longitude values generated by the convert routi
e
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olygons and to view reports of fires within these 
olygons. 

e the path to the GIS layers.  
electing this menu results in the display of the window 
own in Figure 75.   

isplay of a pull-down arrow. Use 

n of 
 map display. A 

IFF file, which has been geo-referenced, will have two files. One will have the extension .TIF 
nd the second will have the extension .TFW. 

 
A Shape file is a GIS layer in the ArcView shape file format.  It consists of three files with 
extensions .SHP, .SHX and .DBF. All three files must exist in the same folder. 
 
 

The GIS Menu 
This GIS (Geographic Information Systems) chapter 
describes PCHA's capabilities to display and manipulate 
spatial data. 

Figure 73 – The GIS Menu 

 
The planner is able to list the GIS layers to be viewed, to 
prepare certain GIS layers, to view the map, to define 
p
p
 
 
Define Make Layers 
Use this screen to defin

Figure 74 – The GIS Menu, 
Define Map Layers Menu 

S
sh
 
 
 
 
 
 
Layer Type ID Column 
Clicking in the box below the 
column name will allow for 

Figure 75  

d
this pull-down to select either 
IMAGE or SHAPE.  This defines 
the format of the GIS file that will 
be used in PCHA. 
 
An Image file must be in Tag Image File Format (TIFF). These image files have an extensio
.TIF.  The image file must be geo-referenced to appear in the correct area of the
T
a
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Complete Path to .SHP or TIF file Column 
The planner has two options to complete this cell entry.  One is to manually type the complete 
path to the .SHP or .TIF file depending on which file type appears in the LayerTypeID column.  
The second is to use the appropriate Browse button to use the Windows File Manager dialog to 
select the .SHP to .TIF file.  PCHA will expect the associated files (.TFW or .SHX, .DBF) to 
have the same filenames and to be in the same folder.   
 
After selecting a layer using the Browse option, the planner MUST click on a different row or 
move to a different row using the arrow keys for the cell entries to be recorded in the PCHA 
database. 
 
When using the Browse option, the entry in the Layer Type column will appear automatically. 
 
After an FMU shape file is selected, the dialog in Figure 66 may look similar to the one in Figure 
75. 
 
Figure 75 –  

 
Outline Color Column Table 20 Available 

Data Colors 
Black Magenta 
Red Cyan 
Green White 
Blue  

If the layer is a SHAPE file, the planner may select a color for the 
layer when the data is displayed on the map. If the color is omitted, it 
will be shown in black. Use the pulldown list to select one of the 
listed colors.  The available colors are in Table 20 
 
To save all information and close the window, click on the small “x” 
in the upper right corner of the window. 
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 dialog  box shown in Figure 78. 

 
Make Fire or Workload Point Shape Files Figure 77 – The Make Fire or 

Workload Point Shape File PCHA has the ability to create shape files showing the 
fire locations in the PCHA database.  It can also create 
shape files with the calculated and manually entered 
workload points by FMU.  
 
Selecting GIS => Make Fire or Workload Point Shape 
Files will result in the
 
Make Fires.shp File Option 
PCHA has the ability to create shape files showing the 
fire locations in the PCHA database.  To create this shape 
file, click in the check box to the left of the Make 
Fires.shp option.  

Figure 78 – Make Shape File 
Dialog 

 
Make CalcPt.shp File Option 
Before this shape file can be created, the planner needs to 
have selected the FPA => Calculate/Edit FMU 
Workload Point menu item.  To create this shape file, 
click in the check box to the left of the Make CalcPt.shp 
option.  
 
Make ManPt.shp File Option 
Before this shape file can be created, the planner needs to  
have selected the FPA => Calculate/Edit FMU Workload Point menu item and then entered 
manually an override location for the workload point for an FMU (Figure 79).  The location of 
the workload is entered using latitude and longitude in degree and decimal format. 
 

Figure 79 – Calculate/Edit FMU Workload Point 
Dialog 

To create this shape file, click in the 
check box to the left of the Make 
ManPt.shp option.  
 
Coordinates 
Select either “Lat/Lon” or “UTM” 
for the desired map coordinates. If 
UTM is selected, the UTM Zone 

Add To Layer List When Done

entered on the File-Planning Unit 
Setup screen will be used. 
 

 
Clicking this box will result in PCHA automatically adding this layer to the list of Map Layers in 
the dialog box shown in Figure 76. 
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screen, there are six icons that function as described in 
Table 23. 

Figure 82  

 Figure 80 
Click OK to begin.  PCHA may 
work for several minutes 
preparing the shape file(s).  An 
example of the Display Map 
Layers dialog (once all four shape 
files have been created) is shown 
in Figure 80.  

Figure 81 – The View Map From 
GIS Menu 

 
View Map 
To view the map with the layers that are listed in the Map 
layers dialog (Figure 80), select GIS => View Map.  A 
map with the data layers will appear.  It may appear 
similar to the one in Figure 82.  In the upper left of the 
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e file.  

entified by one of the methods: 
 

ire number 

• 

nal Interagency Fire Management Integrated Database and applies 

IS => Update Fire Locations From GIS will result in the display of the screen in 

 
Table 23 Description of function of icons 
Icon Function 

 Print the map 

 Return to Full Extent 

 Zoom Out – The map will show twice as much area 

 

Identify the feature clicked on.  First, select a map layer using the pull-down list 
at the bottom of the window.  Second, click on the Identify icon.  Third, click on
a map feature and

 
ap  an Attributes box will appear listing the attributes of the m

feature selected. 

 

Create a zoom area. After clicking, then place cursor at upper left corner of 
desired area.  Hold left mouse button down and drag to create a rectangle
the area to be zoomed to.  Release the left mouse button and P

 around 
CHA will 

redisplay the map showing the area defined in the rectangle. 

 
Pan – Hold left mouse button down and move mouse to pan the map in any 
direction.  Release the left mouse button to complete the panning operation. 

 
 
Update Fire Locations from GIS 
This menu item supports the updating of the latitude and 
longitude assigned to fire records using a GIS shap
The fires in the GIS shape file must have the fires 

Figure 83 -The Update Fire 
Locations From GIS Menu 

id

• Discovery date and f
• NIFMID identifiers 

PCHA record number 
 
NIFMID stands for the Natio
only to Forest Service units. 
 
Selecting G
Figure 84. 
 
Identifying the GIS Shape File 
Click Browse.  Using the windows file manager dialog, navigate to the folder where the GIS 
shape file resides.  Click on this file and then click Open.  The path to the shape file’s location 

ill be displayed in the gray window above the Browsew  button. 
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Figure 84 -  The Correct Fire Locations from GIS Lay Dialog 

 
Discovery Date and Fire Number 
In the cells provided, enter the field name for the fire’s Discovery Date and the Fire Number in 
the database that supports the GIS shape file. 
 
NIFMID Identifier 
In the cells provided, enter the field name for the fire’s Agency, Administrative Unit, Year of 
Discovery and the Fire Number in the database that supports the GIS shape file. 
 
PCHA Record Number 
In the cell provided, enter the field name for the fire’s PCHA Record Number in the database 
that supports the GIS shape file. 
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atershed. 

tain information about the 
olygons to use.  Selecting the GIS => Define Polygons 

ield the dialog box shown in Figure 86. 
 

escribe Column 
ion of the polygons desired for use. 

se Layer Column 
to select the GIS layer previously entered into your list of Map Layers. 

ield Name Column 
field in this layer that is to be used to label the polygons.  

nter the starting date for the fires you want to count.  Complete this entry for all data layers 
t apply, i.e. FMU data layer. 

ending date for the fires you want to count. Complete this entry for all data layers even 
ough it may not apply, i.e. FMU data layer.  Click on the X

 
Define Polygons Figure 85 – The Define Polygons 

Menu PCHA has the ability to count the number of fires and 
acres within each polygon of a GIS shape file. For 
example, the planner could use a watershed polygon 
shape file to count the number of fires within each 
w
 
Prior to preparing such a report of fires and acres by 
polygon, PCHA must con
p
menu will y

Figure 86 

 
D
Enter a brief descript
 
U
Use the pull-down list 
 
F
Enter the name of the 
 
Date From Column 
E
even though it may no
 
Date Thru Column 
Enter the 
th  in the upper right corner to save 
nd exit. 

 
 

a
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 the one in Figure 88. 

elect from the list of polygons you have created (Figure 

rom Date 
rting date for fires. 

hru Date 
ate for fires. 

IS Layer Uses 

 
Fires by Polygon Figure 87 – The Fires by Polygon 

Menu Use this menu item to count the number of fires and acres 
burned within each polygon of a layer you have already 
defined using the GIS => Define Polygons menu item.  
Selecting this menu item will produce a window similar 
to
 
Previously-Defined Polygon Layer To Use 
S
88). 
 
F Figure 88 
Enter the sta
 
T
Enter the ending d
 
G
Select Lat/Lon or UTM. 
 
Click OK and the process will begin, 
using the PCHA map display. When it 
has completed the process, the map will 

isappear, and a two-section report will 
e shown.  

e first section, as shown in Figure 89, shows the number of fires, listed by statistical cause for 
each of the polygons. 
   

Figure 89 

d
b
 
 
 
Th
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The second portion of the report shows acres burned, listed by statistical cause within each 
polygon (Figure 89). 
   

Figure 90 

 
 
These reports can be printed by clicking on the printer icon in the upper left corner of the screen. 
The name of the file holding this text file is shown on the window title bar. 
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atistical and physical characteristics of the fire.  The 
d to a fire event are shown in Table 24 

ire Identifier 
This is an internal identifier assigned by PCHA to the fire 
event. 
 
T l

atural) 
s/No) 

it (FMU) 
• ERCg for Ignition Date 

on Date 

• WFU Fire Duration (Successful WFU Fire) 
• Final Fire Size (Successful WFU Fire) 
• Final Fire Size (Unsuccessful WFU Fire) 

 
The FPA Menu Figure 91 – The FMA Menu 
The items on the FPA menu facilitate the processes that are 
unique to the use of PCHA to support the creation of a fire 
event scenario in FPA. 
 
Fire Event 
A fire event is a single wildland fire measured in time from 
its estimated ignition time through its life, until out.  A fire 
event is the collective sum of attributes that describe the 
st
attributes assigne
 
F

ab e 24 
• Fire Identifier 
• Sensitivity Period (26 in a year) 
• Date Identifier (Julian Date) 
• Fire Discovery Time 
• Fire Cause (Human or N
• Simultaneous Fire (Ye
• Fire Management Un

• Elevation (feet) 
• FBPS Surface Fuel Model 
• Rate of Spread 
• Fire Intensity Level 
• Spread Minutes Until Civil Sunset 
• Final Fire Size (Wildfire) 

• BIg for Igniti
• NFDRS Slope Class 

 
Sensitivity Period 

period, measured in two-week intervals throughout the calendar year, used for 
tive. 

Fire Discovery Time 
This is the fire event discovery time expressed in military time. 
 

This is the time 
describing the resource/fire management objec
 
Date Identifier 
This the Julian date of the fire event ignition. 
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Fire Cause 
If the fire statistical cause is not lightning then it is human-caused.  This attribute of a fire event 
is used in the decision process for possible assignment of a fire event as a candidate wildland fire 
use fire. 
 
Simultaneous Fire (Yes/No) 
If two more or fires occur on the same day in the FPU, each of these fires is designated as a 
simultaneous fire. 
 
Fire Management Unit (FMU) 
This is the internal FMU identifier assigned to the FMU by the FPA-PM program. 
 
ERCg for Ignition Date 
This is the NFDRS Energy Release Component (ERC) using fuel model G calculated using the 
weather data set for an FMU.  This attribute of a fire event is used in the decision process for 
possible assignment of a fire event as a candidate wildland fire use fire. 
 
BIg for Date 
This is the NFDRS Burning Index (BI) using fuel model G calculated using the weather data set 
for an FMU.  This attribute of a fire event is used in the decision process for possible assignment 
of a fire event as a candidate wildland fire use fire. 
 
NFDRS Slope Class 
This is the NFDRS slope class at the ignition location for the fire.  It is used in FPA-PM as one 
input to the determination of fire preparedness resource fireline production rate. 
 
Elevation (feet) 
This is the elevation above sea level for the fire ignition point.  It is used in FPA-PM to regulate 
helicopter use on the fire event. 
 
FBPS Surface Fuel Model 
This is the FBPS fuel model. It is used in FPA-PM as one input to the determination of fire 
preparedness resource fireline production rate. 
 
Rate of Spread 
This is the forward rate of spread of the fire on the day of discovery. 
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Fire Intensity Level (FIL) Table 25 
FIL Flame Length 

1 0 – 2.0 feet 
2 2.1 – 4.0 feet 
3 4.1 – 6.0 feet 
4 6.1 – 8.0 feet 
5 8.1 – 12.0 feet 
6 12.1+ feet 

This is the fire intensity level of the fire on the day of discovery.  
The FIL is determined by the flame length (Table 25). 
 
Spread Minutes Until Civil Sunset 
This is the number of minutes from the fire discovery time to 30 
minutes after sunset. 
  
Final Fire Size (Wildfire) 
This is the fire size if the fire event is not contained b FPA-PM. 
 
WFU Fire Duration (Successful WFU Fire) 
This is the number of days from the WFU fire event’s discovery date until the date of the fire 
ending weather event. 
 
Final Fire Size (Successful WFU Fire) 
This is the fire size for a fire event that the FPA-PM manages as a WFU fire. 
 
Final Fire Size (Unsuccessful WFU Fire) 
This is the fire size for fire event that is a candidate WFU fire and FPA-PM does not manage as a 
WFU fire. 
 
Fire Event Scenario 
A fire event scenario is a representation of the annual initial response fire activity based on 
historic fire occurrence.  The fire event scenario is a collection of fire events based on 
probabilities or defined deterministically for use in FPA-PM.  There are two processes that are 
used to define a fire event scenario. 
 
Probability-based Fire Event Scenario 
Random draws from fire occurrence distributions are used to generate the fire events in a fire 
event scenario.  Historic fire frequency is one foundation of the process.  Fuel moisture values 
and a wind speed are assigned to a fire event based on probability distributions generated using 
historic weather data.  Topographic and fuel conditions are also determined by a random draw 
based on the relative occurrence of these attributes.  

 
Historic-based Fire Event Scenario 
PCHA selects a single staffing season to determine the fire discovery date and fire discovery 
time for the fire events in a fire event scenario.  Fire behavior for each fire event is determined 
using the same weather conditions on the date the fire occurred as well as the topographic and 
fuel conditions that it burned in as defined in the agency’s corporate fire report. 
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Import FPA-PM Layer to Start New Analysis 
PCHA needs certain information regarding the FPU.  PCHA 
needs the unique system provided identifier used by FPA-
PM to identify the FPU.  This identifier is necessary so that 
the two programs, FPA-PM and PCHA, are able to merge 
their respective data.  PCHA needs to know the FPU name.  
PCHA needs a GIS shape file of the FMUs in the FPU.  The 
attributes of the shape file provide information on a unique FMU identifier and FMU name. 

Figure 92 

 
Before this menu item can be implemented, the user must download the GIS shape file created 
by FPA-PM.  The file created will be a zip file.  Extracting that file will yield three files: 
 

• fmu.dbf 
• fmu.shp 
• fmu.shx 

 Figure 93 

 
 
Figure 94 

Selecting the FPA = > Import FPA-
PM Layer to Start New Analysis 
menu will bring up the screen in 
Figure 93.   
 
Click Browse to open the Windows 
File Manager dialog box which allows 
the planner to navigate to the folder 
where the GIS shape files have been 
download from FPA-PM (Figure 93).   
 
Click on the fmu.shp file and then 
click Open.  The screen in Figure 93 
will reappear with the path to the file 
displayed in the gray window.   
 
Click Import to complete the activity. 
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MUs shape file from FPA-PM using the FPA = > 

emaining columns have a blank 
eld value since processes within FPA to populate this 

w with the FMU-Name in the Slope Class 
olumn.  The five slope class options as shown in Table 26 will appear.  Click on the desired 

 
Figure 96 

 
Edit FMU Slope Class Figure 95 
An average NFDRS slope class needs to be assigned to 
each FMU (Table 26).  Selecting the FPA => Edit FMU 
Slope Class menu will result in the display of the screen 
shown in Figure 96.  The screen in Figure 96 is displayed 
as it would appear immediately following import of the 
F
Import FPA-PM Layer to Start New Analysis menu. 
 
Note there are field entries for the FMU_ID and the 
FMU_Name.  All of the r

Table 26 
NFDRS 

Slope Class 
Slope 

Breaks 
Slope 
Used 

1 0 - 25% 22.5% 
2 26 - 40% 31.8% 
3 

fi
field have not occurred. 
 
At this time, the planner should assign to each FMU a 
representative average NFDRS slope class.  Click in the 
cell on the ro

41 – 55% 44.5% 
4 56 – 75% 63.6% 
5 76+% 90% 

c
slope class. 
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 for each FMU using the FPA => Create FMU 
eather Data Set menu. 

the planner needs to have defined a weather station 
sing the File => Weather Stations menu. 

 
 

the day of interest.  
hese will be referred to as weather station/observation day combinations. 

e 

 
Assign Weather Station to FMUs Figure 97 
This menu item will facilitate the assigning in priority order 
of the weather station and the observation day to be used to 
assign a weather observation to each day within the analysis 
period.  Once completed, PCHA can then create a weather 
data set
W
 
Before this menu activity can be completed, 
u
 
Selecting the FPA => Assign Weather Station to FMUs menu will result in the display of the 
dialog similar to the one shown in Figure 98.  As initially displayed, the FMU list will appear in 
the window on the left and the other two windows will be blank.  Clicking on an FMU will cause
the weather stations defined via the File => Weather Stations menu to be displayed.  Note that
for each weather station, there are three options provided for a weather observation.  These are 
the day of interest, the day prior to the day of interest and two days prior to 
T
 
To assign the primary weather station/observation day combination to the FMU, click on it in th
center window and then click  =>>.  In the example in Figure 98, selecting the weather statio
044701 (Ash Mountain) as the primary w

n 
eather station/observation day combination would 

sult in a screen as shown in Figure 99. 

Figure 98 

re
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Figure 99 

 
 
Assigning weather station/observation day combinations might result in a priority listing as 
shown in Figure 100.  The planner should continue this process for each FMU. 
 
By clicking on a weather station/observation day combination in the right window, the planner 
can move that weather station/observation day combination up or down in the priority listing by 
clicking Up or Down. 
 
Figure 100 
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sign Weather Station to FMUs menu.  
he FPA => Assign Weather Station to activity must be completed before this 

in 
  

 
Create FMU Weather Data Set Figure 101 
This menu item will facilitate the assignment of a weather 
observation to each day within the analysis period.  This is 
done for each FMU and the resulting assignments allow for 
the definition of a weather data set for the FMU.  The 
weather observations assigned to a day for each FMU is 
based on the prioritization of weather station/observation 
day combinations accomplished using the FPA => As

FMUs menu T
activity. 
 
Selecting the FPA => Create FMU 
Weather Data Set menu will result 
the display of the dialog in Figure 102.
To proceed, click OK.  PCHA will 

Figure 102 

display the FMUs’ names as it works, 
 complete the activity, click OK infinally displaying a Done message.  To  the Done dialog box. 

electing this menu will result in the preparation of a 

u 

ithin the Fire 
reparedness Staffing Season.  If this box is unchecked, 

the listing will be done of the entire year. 
 
Figure 105 

 
View Missing Weather Report Fi ure 103 g

 
 
Figure 104 

S
report similar to the one shown in Figure 105.   
 
Select the FPA => View Missing Weather Report men
and the dialog in Figure 104 will appear.  Check the box 
if you desire to see a listing of FMU/date combinations 
with no weather observation assignment w
P
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Determine Waiting Time Distribution Figure 106 
Reserved for later completion. 
 
 
 
 
 
 
 
Report Possible Duplicate Fires Figure 107 

 
 
Figure 108 

With interagency partners participating in an FPU, it is 
possible for a historic fire to have a fire report record for 
each agency in the database.  This can happen if both 
agencies that responded to the fire completed their 
agency’s fire report.   
 
Selecting FPA => Report Possible Duplicate Fires will 
result in the display of the dialog in Figure 108.  Click 
OK to have PCHA prepare the report. 
 
This menu item will produce a report that contains 
possible duplicate fire report records.  An example report 
is shown in Figure 109.  Note:  the Paradise fire has a fire 

port record from both the Forest Service and the BLM. 

Figure 109 

re
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It is recommended that the fire record from the agency that manages the land be the fire record 
retained. The fire that is the duplicate record can also be removed from the analysis by checking 
the box on the FPA tab to exclude duplicate fires. 
 
To designate a fire record as a duplicate record, select Fire => Edit Fires => FPA.   Note: the 
Paradise Fire occurred on 5/25/2003.  Click Search Criteria.  Enter Paradise in the Fire Name 
cell and 5/23/2003 in the Discovery Date cell.  Click Begin Search.  The dialog in Figure 111 
will appear.  Note the text in the lower left “EDIT 1 of 2.”  This indicates two fire records have 
been selected.   
 
Figure 110 
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The Paradise fire was located on Forest Service land so the Forest Service fire record should be 
the one used in PCHA.  Select the BLM fire record and click on the FPA tab.  Click in the box 
titled PCHA for FPA Should Exclude This Duplicate Fire (Figure 111).  Then click Save. 
 
Figure 111 
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equency distributions can be developed. 

g 

 
Fires Missing Data Required for FPA Figure 112 

 
 
Figure 113 

Required information from the fire report for each 
historic fire to be used for the probability-based fire event 
scenario process includes: 
 

• Fire Type/Protection Type code for DOI agency 
fires 

• Fire location 
• Discovery date 

 
Some information from the fire report for each historic 
fire is used to develop frequency distributions.  Random 
draws from these distributions are used in the probability-
based fire event scenario generation process.  Frequency 
distributions are developed for: 

 
• Discovery time 
• Fire control date 
• Statistical cause 

 
These are desired data fields and there needs to be an 
adequate number of fires with values for these so the 
fr
 
Selecting FPA => Fires Missing Data Required for FPA will result in the display of the dialo
in Figure 113.  Select the fires you desire to include and then click OK to have PCHA prep
the report.  This menu item will produce a report that lists fire records with some m

are 
issing 

quired and/or desirable data fields.  An example report is shown in Figure 114. 

Figure 114 

re
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 needs to be 
hecked for accuracy. 

mport FPA-PM Layer to Start 
ew Analysis menu brings up the screen in Figure 116.    

 
Assign Fires to FMU Using GIS 
This menu item facilitates the assignment of an FMU to 
each historic fire.  This is done using the GIS capability 
within PCHA.  All fires must have a location expressed in 
latitude and longitude.  In addition, this location

Figure 115 

Figure 116 

c
 
Selecting the FPA = > I
N
 
Click Browse to open the Windows
File Manager dialog box  allowing 
the planner to navigate to the folder 
where the GIS shape files have been 
downlo

 

aded  from FPA-PM (Figure 
17).    

Figure 117 

1
 
Click on the fmu.shp file and then 
click Open.  The screen in Figure 
116 will reappear with the path to 

lick OK

the file displayed in the gray 
window.   
 
C  to complete the activity.  
PCHA will do this assignment and 
when complete, a dialog will appear 
indicating Fires have been assigned.   
Click OK. 
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View FMU Assignment Results Figure 118 
This menu item produces a report showing the assignment 
of fires to FMUs and a listing of fires that have not been 
assigned to an FMU.  The most likely reason a fire would 
not be assigned to an FMU is the location of the fire is 
outside of all FMU boundaries.   
 
Selecting the FPA = > View FMU Assignment Results 
menu will produce the screen in Figure 119.  Click OK and 
a report similar to the excerpt shown in Figures 120 and 121 
will appear.  Figure 120 shows the first part of the report  
with the number of fires assigned to each 
FMU.  Figure 121 shows the second part 
of the report, which is a listing of fires 
that have not been assigned to an FMU. 

Figure 119 

 

Figure 120 

 
 
Figure 121 
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Calculate/Edit FMU Workload Point 
The FPA-PM model requires a fire workload point for 
each FMU.  PCHA will determine this point by obtaining 
an average of all latitude and longitude locations for each 
fire included in each FMU.  This menu item facilitates the 
calculation of a workload point for each FMU. 
 
Selecting the FPA = > Calculate/Edit FMU Workload 
Point will implement this activity and a screen similar to 
the one in Figure 123 will appear.  The PCHA calculated 
latitude and longitude are in the Calc Lat and Calc Lon 
columns respectively.  The planner can override this 
calculated value by entering a latitude and longitude in the Man Lat and Man Log columns 
respectively. The workload point locations that are determined can be reviewed by using the 
features found in the GIS menu.  The points can be displayed and mapped on the FMU polygons 
along with the fire locations. 

Figure 122 

 
Figure 123 

 
Identify FMU ASCII Grid Files 
An ASCII Grid file is a file containing alphanumeric values for landscape features such as slope, 
aspect and elevation.  Digital Elevation Models (DEMs) are digital files consisting of points of 
elevations, sampled systematically at equally spaced intervals. DEM digital files are available for 
the entire United States from the U. S. Geological Service (USGS).  The spatial relationship of 
these points is used to derive the slope and aspect values by referencing adjacent elevation 
points.   
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The fire planner needs to work with local GIS specialists to develop ASCII Grid files.  Refer to 
the Appendix for guidelines on how to prepare these files.   Each FMU must be totally enclosed 
within only one set of grid files. In other words, one grid file may include numerous FMUs (or 
the entire FPU), but an FMU may not be split, requiring two different grid files. FMU polygons 
may be discontinuous.   
 
Grid File Naming 
The planner will need matched sets of Grid files.  The files in each set must exactly cover the 
spatial area.  Each ASCII Grid file for an FMU must have a file name formatted as follows: 
 

   BaseFileName_DataLayer.asc,  
 

• BaseFileName is an identifier such as CenOrEastside. 
• DataLayer is the data that is in the Grid file.  
• Each file in the set must have a file extension of .asc 

 
Table 27 

Attribute Required 
in FPA 

Data 
Layer ID Example 

Slope Yes slope southsierra_slope.asc 
Aspect Yes aspect southsierra_aspect.asc 
Elevation Yes elev southsierra_elev.asc 
FBPS Fuel Model  fuel southsierra_fuel.asc 
Canopy Cover  canopy southsierra_canopy.asc 
Canopy Base Height  cbh southsierra_cbh.asc 
Canopy Bulk Density  cbd southsierra_cbd.asc 
Stand Height  height southsierra_height.asc 

Table 27 provides 
a summary of the 
requirements. 
 
Once prepared, 
these files need to 
be imported into 
PCHA.  Selecting 
FPA => Identify 
FMU ASCII Grid 
Files will facilitate 
this process  
(Figure 124).   Figure 124 
 
The dialog in Figure 125 will be displayed.  The dialog is 
used to identify to PCHA the folder location where the 
ASCII Grid files reside as well as the units of each of the 
Grid Files.   
 
FMU 
Use the pull-down to select the FMU the Grid file cover.   
 
Units 
Click the radio button on the Units area to designate the 
units the grid is in. 
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Elevation Grid File Figure 125 
Click Browse and use the Windows dialog to 
navigate to the file location where the 
BaseFileName_elev.asc file is located.  In the 
example in Figure 125, the file location is 
displayed in the “Look in”cell and the file name 
is southernsierra_elev.asc.  Note that all of the 
ASCII Grid files must reside in the same folder 

 Grid elevation file.  Click Open as the ASCII
and the file path should appear in the cell to the 
right of the Elevation Grid File title (Figure 
126). 
 
Figure 126 
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Units of the Slope, Aspect and Elevation Grid Files 
Select the appropriate units 
for each of the topographic 
ASCII Grid data layers 
(Figure 127).   

Figure 127 

 
Elevation 
Use the radio button to select either feet or meters. 
 
Slope 
Use the radio button to select either degrees or percent. 
 
Aspect 
Use the radio button to select either aspect category (1-25) or degrees. 
 
Using Spatial Fuel Type Attribute Data Layers 
If an ASCII Grid file will 
be use to define fuel types 
for an FMU, check the Use 
Fuel Type GRID Files 
box and select the 
appropriate units for each 
of the fuel type ASCII Grid data layers (Figure 128). 

Figure 128 

 
Fuel Model 
The fuel models must be from the Fire Behavior Prediction System (FBPS) (Anderson 1982).  
No custom fuel models are allowed.  Use fuel model 98 to designate water and fuel model 99 to 
designate unburnable. 
 
Canopy Cover Table 28 – Definition of Canopy Cover Categories 

Category Range Used in Calculations 
0 0% 0% 
1 1 – 20% 10% 
2 21–50% 35% 
3 51-80% 65% 
4 81-100% 90% 

Canopy cover is normally measured as 
a percent.  It is based on the lineal 
length that is within a canopy versus 
in the open. Click the appropriate 
radio button to specify the units as 
either Category (0-4) (Table 28) or the 
percent. 
 
Stand Height 
For an individual tree, height is the measurement to the top of the tree tip.  Averaging the heights 
for all trees in a stand would give an estimate of the stand height. Click the appropriate radio 
button to specify either meters, meters * 10, feet or feet * 10. 
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Canopy Base Height (1-299 feet) 
For an individual tree, the measurement of the height to the base of the crown can be made.  The 
averaging of these values for all trees in a stand would give an estimate of the level of the stand 
canopy base height.  Frequently, this is a measure of where the limbs of the canopy start 
vertically, but the number can be skewed by the presence of small trees or occasional live limbs.  
A more meaningful value would be the height above the ground of the first canopy layer where 
the density of the crown mass within the layer is high enough to support vertical movement of a 
fire.  Click the appropriate radio button to specify either meters, meters * 10, feet or feet * 10. 
 
Canopy Bulk Density (kg/m3) 
Mathematically, canopy bulk density (CBD) (kg/m3) is canopy biomass divided by the volume 
occupied by crown fuels.  Canopy bulk density is hard to estimate in the field.  Initially, it seems 
attractive to calculate this value by treating the canopy as a box with the depth ,the stand height, 
minus the canopy base height.  Assuming this box covered an acre (43,560 ft2), dividing the fuel 
loading in the canopy by the volume of box would provide an estimate of average canopy bulk 
density.  Unfortunately, this estimate has a bias toward underestimation of the canopy bulk 
density due to the averaging of largely void areas in the top and bottom of the canopy with the 
more dense layers of foliage.  A fire burning vertically within the crowns will most likely 
propagate through denser canopy layers.  Click the appropriate radio button to specify either 
kg/m3, kg/m3 * 100, lbs/ft3 or lbs/ft3 * 100. 
 
Assigning More Than one FMU to a Set of Grid Files 
At the bottom of the 
dialog shown in Figure 
129 is an area where the 
planner can identify 
additional FMUs that 
have the same set of 

lick on an FMU to 
entify it as an FMU 
ith the same set of 
RID files as the one shown in the Elevation Grid File cell.  Click Select ALL

Figure 129 

GRID files as the one 
shown in the Elevation 
Grid File cell.   
 
C
id
w
G  to identify all of 

e FMUs in the FPU to have the same set of GRID files as the FMU shown in the Elevation 
rid File cell.  Click Clear ALL

th
G  to reverse the action from Select ALL. 
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II 
 

re 

 
Collect FMU ASCII Grid Information 
This menu item facilitates the importing of the FMU ASC
Grid files into PCHA.  Selecting FPA = > Collect FMU
ASCII Grid Information menu will result in a dialog 
screen.  The lower portion of that screen is shown in Figu
131.  Click Browse to open the Windows File Manager 
dialog box to allow the planner to navigate to the folder
where the GIS shape files

 
 have been downloaded from 

PA-PM (Figure 132).   F
 
Click on the fmu.shp file and then click Open.  The 
in Figure 131 will reappear with 

screen 
the path to the file 

isplayed in the gray window.   d
 
Click Ok to complete the activity (Figure 131).  PCHA will import the Grid files when the 
activity is complete, a dialog box will appear indicating the import has been completed.  Click 

KO . 

Figure 131 Figure 132 
 

 

Figure 130 
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xist in any of the FMUs that will have fuel types 

nit GIS files.  The fire planner can determine the specific attributes needed for 
efining a fuel type with the assistance of other fire personnel having fuels expertise and a local 

o define fuel types for the FPU, select FPA => FPU Fuel Types menu (Figure 133). The 
window shown in Figure 134 will appear.   
 

Figure 134 

 
FPU Fuel Types 
In review, a fuel type is a unique combination of the 
following: 
 

• Canopy cover 
• Surface (FBPS) fuel model 
• Canopy base height 
• Canopy bulk density 
• Stand height 

 
If at least one FMU in the FPU will have fuel types 
defined non-spatially, then the planner will need to 
define each of the fuel types.  All fuel types that 
e
defined non-spatially needs to be defined. 
 
The information for fuel layers may be developed from existing vegetation data layers in 
administrative u

Figure 133 

d
silviculturist.   
 
T

 
The planner should complete the cell entries for all fuel types that are in FMUs that will have 
fuel types defined non-spatially.  An example is shown in Figure 135. 
 

Figure 135 
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FMU Fuel Type Percents 
The planner needs to manually enter the proportion of 
each fuel type in each FMU that will have fuel types 
defined non-spatially.  These proportions can be 
determined by using a GIS or by using professional 
judgment to estimate from remote sensing images.  
 
Select FPA => FMU Fuel Type Percents.  Click on an 
FMU to select it and a dialog similar to Figure 137 will 
appear. .  Click on the fuel type desired in the right 
window.   Enter the percent of the FMU that is in the 
fuel type in the box labeled Percent and then click 
Save.  Do this for each fuel type in the FMU.  Note that 
the sum of the percentages in an FMU must be 100%. 

 
Also note that the entered values are not saved until 
the user clicks on another FMU name different from the one being defined. 

Figure 136 

 
Figure 137 
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Calculate ERCg and Wind Speed Bins, Fire Probabilities 
PCHA automates the creation of several necessary 
probability distributions and tables required for the 
creation of fire event scenarios.   A detailed 
description of the process used by PCHA is contained 
in the FPA Reference Guide. 

Figure 138 

  
To perform this activity, click FPA => Calculate 
ERCg and Wind Speed Bins, Fire Probabilities.  
The dialog shown in Figure 139 will appear.  Click 
OK.  
  
Figure 139  

 
 
 
 
 
 

When done, a Calculations Complete dialog will 
appear.  Click OK to close that dialog screen. 
 
Determine Preparedness Staffing Season Figure 140 
PCHA contains a screen that shows fire danger 
variables and a distribution of fire occurrence in a 
calendar year.  To access this screen, select FPA => 
Determine Preparedness Season (Figure 140).  The 
screen in Figure 141 will be displayed.  At the top, the 
planner can view a bar graph of ERCg, SCg or BIg 
through the year for the FPU.  At the bottom of the 
screen, the planner can view average fire occurrence 
per day for the Analysis Period.   
 
The Preparedness Season is then defined by the 
planner in the box in the lower right part of the screen.  
Note that multiple discontinuous periods can be 
designated.  In Figure 142, there is a display of the 
time of the year when 90% of the fires happen and is 
noted as the fire preparedness staffing season in this 
example. 
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Figure 141 

 
 
 

Figure 142 

 
 



 

PCHA 1.2 Users’ Guide – 10/18/2004 - Draft Page 99

e Event Scenario.  
he dialog in Figure 144 will appear.  Click OK

Prepare Historic-based Fire Event Scenario 
Reserved for later use. 
 
Prepare Probability-Based Fire Event Scenario 
A probability-based fire event scenario is a collection 
of fires that represents one year of fire occurrence 
within an FPU.  The fires are randomly created and 
attributed using probability matrices created from 
historic data.  To perform this activity, click FPA => 
Prepare Probability-based Fir
T  to 
p
 

fter OK

roceed. 

 
A  is clicked in response to the prompt, PCHA 
will run for a while preparing the fire event scenario. 
When it is finished, it will automatically prepare the XML file (Figure 145).  Click OK to 
comp te the activity. 

 
 
 
 
 

 

Figure 143 

Figure 144 

le
 

Figure 145 
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View FPA Scenario Details Figure 146 
The planner can now view a series of reports about the 
fire event scenario.  The reports can be accessed using 
the FPA menu in PCHA.  Select FPA => View 
Scenario Details and the dialog in Figure 1467 will 
appear.   
 
Figure 147  

 
 

 
Select the reports that are desired for viewing. 
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he planner can customize the title of a 

 
e 

 
The Reports Menu Figure 148 – The Reports 

Menu PCHA can generate and print a variety of reports and graphs.  
 
 
 
 
 
Database Queries Figure 149 – The Database Queries Menu 
Each of these reports allows the 
planner to enter the period of years for 
the data to be included in the report.  
T
report (Figure 151). 
 
Database Queries Reports Available 
Figure 150 shows the reports available under the Reports =>
Database Queries menu item.  To create a report, select th
menu that is desired.  Enter the beginning and ending years 
for the period that data is desired from and then click OK. 
Enter a title (Figure 151) and c

Figure 150 – Database 
Queries Reports Available 

 
Figure 151 – Custom Naming 

f a Report Dialog o

 
 
Figure 152 – Location of Path 
and File Name 

lick OK to generate the report.  
o close the Report window, click on the XT  in the upper right 

 window. corner of the display
 
Printing a Report 
When the report is displayed on the screen, click Print in the 

print the report.  upper left corner to 
 
Report Text Files 
When PCHA creates a report, it saves that report as an A
text file in the folder where PCHA is installed.  The path
the file and the file name appear at the top of the report 
display window (Figure 152).  These report files can be 
viewed in any word processing program.  Note that a C

SCII 
 to 

ourier 
nt must be used for this text.  Assigning a proportional font 

to the text will cause the report to appear incorrectly. 
 

fo
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Description of Reports 
A description of each report follows. 
 

Figure 153 – Example from the 
of Fires and Acres by Size 
Class Report 

Fires and Acres by Size Class Report 
PCHA will create a report named FBYSZ.TXT that lists the 
number of fires and acres burned by year and size class. The 
setup screen allows the planner to select any combination of 
fires by statistical cause.  The top line of each pair shows 
the number of fires and the lower line shows acres burned 
(Figure 153). The setup screen allows the planner to select 
only lightning fires, only human caused fires, or any 
ombination of fires by statistical cause. c

 
Fires and Acres by Statistical Cause Report 
PCHA will create a report named FBYSTAT.TXT that shows the number of fires by statistical 
ause.  c

 
Figure 154 – The Fires Within 
Lat/Lon Report Setup Dialog 

Fires Within Lat/Lon Report 
PCHA will create a report named REPLL.TXT that lists 
fires within a rectangle defined by the planner. The planner 
will need to enter the latitude and longitude in degrees an
minutes for the northwest and southeast corners (
154). After entering the northwest and southeast 
coordinates, click OK

d 
Figure 

. The report lists the boundaries 
entered as well as the discovery date, fire number, township, 
range, section, subsection, meridian, latitude, and longitude 
or each fire located within the rectangle defined. f

 
Figure 155 – The Large Fires 
Report Setup Dialog 

Large Fires Report 
PCHA will create a report named LargeFires.TXT.  Th
report lists all fires in the FPU during the time period 
specificed that had a final fire size greater t

is 

han the one 
efined in the setup window (Figure 155). 

 

d
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Multiple Fire Occurrences by Days Figure 156 – The Multiple 

Fire Occurrences by Days 
Report Menu 

This report lists the number of fires per day and the number of 
days that each fire occurrence situation occurred in the 
analysis period. For example, if the FPU had six fires, three of 
which occurred on a single day, and the other three were on 
different days, the report would show two lines: one line for 3 
fire days with 1 fire per day, and 1 day with 3 fires per day. 
The report is titled MULTFIRE.DAT. 
 
Graphs Figure 157 – The Graphs Menu 
Two graphs are available.  These are: 
 

• Fires and Acres by FIL 
• Multiple Fire Occurrences by Days 

 
The screens for each graph allow the planner to choose the range of years to include, to define a 
major title and to print the graph.   
 
Fires & Acres by FIL Graph Figure 158 – The Graphs Menu 
This menu item allows the planner to graph 
the number of fires or acres burned by Fire 
Intensity Level.  
 
Step 1 
Click on the radio button to select the graph 
type from the options given in the lower 
right corner. 
 
Step 2 
Enter the From and Through years. 
 
Step 3 
Use the pull-down to select the FMUs to use. 
 
Step 4 
Click Graph to display the graph. 
 
Step 5 
Click Titles to enter a unique major graph title, which appears at the top of the graph.  In the 
example in Figure 158, this title has been entered as Example for Users’ Guide. 
 
Click Print to print the graph and click Exit to close the dialog screen. 
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fter generating the 
raph it can be printed by clicking 

 
Multiple Fire Occurrence by 
Days 

Figure 159 – The Graphs Menu 

This function allows the planner to 
graph the number of fire days by 
the number of fires discovered on 
that day. A
g
Print. Clicking Titles and entering 
the preferred text can add subtitles. 
 
Step 1 
Enter the From and Through years. 
 
Step 2 
Click Graph to display the graph. 
 
Step 3 
Click  Titles to enter a unique major graph title, which appears at the top of the graph.  In the 

Fires by Multiple Fire 
ccurrence Events. 

example in Figure 159, this title has been entered as Total Number of 
O
 
Click Print to print the graph and click Exit  to close the dialog b

ustom Reports 
eed to add info when I understand this process. 

 
 
 

ox. 
 
C Figure 160 – The Custom 

Reports Menu N
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The Utilities Menu Figure 161 – The Utilities 

Menu The Utilities menu has many tools and aids to support work 
by the fire planner.  The Utilities menu is shown in Figure 
161.  
 
 
 
 
 
 
 
 
 
 
Database Browser Figure 162 – The Database 

Browser Menu This menu allows the planner to view the information that is 
in the data tables in the PCHA database. An example of the 
Database Browser menu screen is shown in Figure 162.   
 
In the example in Figure 163, the Fire data table has been 
selected.  To view any database table, click on the table 
name in the column on the left side of the screen.  Click on 
the scroll bar along the bottom to move the viewing window 
right or left. To move up or down, use the scroll bar on the 
right side of the window.  To exit the window, click X in the 
upper right corner of the window. 
 
Figure 163 – Example of Database Browser Screen 
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This window allows the planner the opportunity to view but not change information contained in 
the data tables of the PCHA database.  PCHA displays the internal representation of the data 
hence some of the entries may appear confusing.  For example, township -3 means 3S. Values in 
the Herb_Annual field are 0 and –1, which are binary numerical representations for Yes and No. 
 
Displays can be sorted by the value in a column.  To do this, click on the column header.  It will 
sort the complete set of records based in the values in the selected column.  Clicking again will 
sort the records in the reverse order.  It is not possible to drag and drop columns in the display.  
 
Database Structure Figure 164 – The Database 

Structure Menu This menu allows the planner to view the structure of the 
PCHA database.  Selecting this menu will result in a report.   
 
An excerpt of this report is shown in Figure 165.  The report 
lists the tables in the database together with each field and 
that field’s data type. To move up or down, use the scroll 
bar on the right side of the window.  To exit the window, 
click X in the upper right corner of the window.  The report 
is saved in the folder where PCHA is installed with a file 
name of DBSTRUCT.REP. 
 
 
 

Figure 165 – Example of Database Structure Screen 
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View Base Meridians Figure 166 – The View Base 

Meridians Menu This menu item allows the planner to view the codes for the 
principal meridian.  Selecting this menu will yield a blank 
version of the dialog in Figure 167.  Click Search to see the 
first principal meridian in the database.  An explanation of 
each field and button follows. 
  
NIFMID Code 
This is the alpha code used in NIFMID to identify the 
Principal Meridian. The Planner can search for records with 
this field. The principal meridian name will be displayed. 
 
Code in CONVERT 
The CONVERT program uses a different set of  

Figure 167 – The View Base 
Meridians Dialog 

abbreviations to identify principal meridians. This field 
displays the code used in CONVERT. 
 
Clear Button 
The Clear button deletes entries in the screen boxes to 
facilitate the start of a new search. 

e Save

 
Save Button 
Th  button is academic as an edit cannot be saved.  

ly screen. 

ress Search

This is a view on
  
Search Button 
P  to find the first meridian record in the database. Once a record is displayed, the 
First, Previous, Next, and Last buttons can be used to move through the meridians. 

elete Button 
 
D
The Delete button is academic, as an edit cannot be saved.  This is a view only screen. 
 
First, Previous, Next, and Last Buttons 
The First button displays the first meridian record in the database. The Previous and Next 
buttons display the meridian record before or after the current meridian record. The Last button 

isplays the last meridian record in the database. These buttons show light gray if there are no 
ds in the database. 

rint Button 

d
meridian recor
 
P
The Print button tells the computer to generate a page that looks like the meridian screen. 

Exit Button 
The Exit

 

 button closes the meridian entry screen and returns to the main PCHA screen. 
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 assigns a rate of spread and 
ame length to a historic fire. 

 Site 
efaults to Below, Aspect defaults to North, 

1+%, and Time to 0800. These 

 
py cover/cloud cover and ushaded for areas with a 

anopy cover/cloud cover of 51-100%.   

 directions.  

Time 
Only daylight hours are included, in two-hour bands, since the calculations show only the effects 
of solar radiation on the fuels. 
 

 
Site-Specific Corrections Figure 168 – The Site-Specific 

Corrections Menu This function enables the planner to define various site-
specific values that will then display additions or 
subtractions to fuel moisture values. The calculations are 
developed to make changes to the 1-h timelag fuel moisture 
at a weather observation site to a fire location site.  The 
variables to be used include: 
 

• The month of the year, 
• The time of the day 
• The elevation difference between the weather 

observation site and the fire location site 
• The aspect at the fire location site 
• The shading at the fire location site 

Figure 169 – The Site-Specific Corrections 
Dialog 

• The slope at the fire location site 
 
This utility uses the same process that is used 
in PCHA to assign a 1-h timelag fuel 
moisture to a historic fire during the 
calculation that
fl
 
Month 
Click on the month. Note this sets the defaults 
as follows:  Exposure defaults to Shaded,
d
Slope to 3
defaults must be reset if other values are 
desired. 
 
Shading
Choose unshaded for areas with 0-50% cano
c
 
Aspect 
Choose one of the four cardinal
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Site 
Click on the choice that represents the difference in elevation between the weather observation 
site and the fire location site.  Note that if this difference is greater than 2000 feet, it is advised 
that a correction be made.  A new weather observation site needs to be established that is within 
2000 feet of the fire location site. 
 
Slope 
Choose one of the slope options.  
 
Add to Dead Fuel Moisture 
The red value shows the increase (or decrease) in 1-h timelag fuel moisture value from the 
weather station’s calculated 1-h timelag fuel moisture value. 
 
Exit Button 
The Exit button closes the site specific corrections entry screen and returns the user to the PCHA 
main menu. 
 
Calculate Hours of Daylight Figure 170 – The Calculate 

Hours of Daylight Menu This routine displays the number of daylight hours per day 
for a given latitude and date. Enter the latitude in degrees, 
the date (mm/dd or mm/dd/yyyy are both acceptable), and 
then Calculate. The hours and minutes of daylight will  
appear.  
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s Format 
• UTM 

etermine the location format that is to be converted. 

verted 
 the appropriate area. 

n in 
e Convert FROM section. 

ppear in 
e other three formats. 

 

enu facilitates the conversion of Township, Range, and 
ection to Latitude and Longitude. 

 

 
Location Conversion (LL, TRS, UTNM) Figure 171 – The Location 

Conversion Menu This utility converts any one of the following formats to the 
other three.  The four formats are: 
 

• Township, Range and Section (TRS) 
• Latitude and Longitude in Decimal Format 
• Latitude and Longitude in Degrees, Minutes and 

Second

 
Step 1 
D
 
Step 2: 
Enter the required information 
for the location to be con

Figure 172 – The Location Conversion Menu 

in
 
Step 3 
Click on the appropriate butto
th
 
The location value will a
th
 
Thus utility uses the same 
equations that are used in the
Fire => Calculate Lat/Lon 
From Legal menu function.  This m
S
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FBPS Calculations Figure 173 – The FBPS 

Calculations Menu This utility uses the same equations that calculate rate of 
spread and flame length for a fire event.  It is provided so 
that a planner can test the expected fire behavior in a fuel 
type under a defined set of weather and topographic 
conditions.  Selecting Utilities => FBPS Calculations will 
yield the dialog shown in Figure 174.  Below is a 
description of the inputs and outputs.  In parenthesis 
following each is the range
 

 of acceptable values. 

FBPS Fuel Model (1-13) 
E l model.  Table 29 nter the number of the FBPS fue
c g of these fu
 
ontains a listin el models. 

Figure 174 – The FBPS 
Calculations Dialog 

Tab  FBPle 29 – S Fuel Models 
Fuel Group odel FBPS Fuel M

1 - Short Grass (1 foot) 
2 - Timber (Grass and understory) Grass 
3 - Tall Grass (2.5 feet) 
4 – Chaparral 
5 – Brush 
6 - Dormant Brush Brush 

7 - Southern Rough 
8 - Closed Timber Litter 
9 - Hardwood (pine long needle litter) Timber 

Litter 10 - Timber 
11 - Light Slash 

 

12 - Medium Slash Slash 
13 - Heavy Slash 

1-h Fuel Moisture (1-60%)  
el moisture can be estimated The 1-hour timelag reference fu

using the air temperature and the relative humidity.   
 
10-h Fuel Moisture (1-60%) 
It is suggest the 10-h fuel moisture be set as 1% more than 
the 1-h fuel moisture. 
 
100-h Fuel Moisture (1-60%)  
It is suggest the 100-h fuel moisture be set as 2% more than 
the 1-h fuel moisture. 
 



 

 Page 112                                                                                                                     PCHA User’s Guide – 10/18/2004 

Herb Fuel Moisture (30-300%) 
Enter the moisture content of the grass and forb fuels.  See Table 30 for estimates of this value.  
 
Table 30 – Guidelines for Live Fuel Moisture 

State of Vegetation Development Moisture 
Content 

Fresh foliage, annual developing, early in growing cycle 300% 
Mature foliage, still maturing with full turgor 200% 
Mature foliage, new growth complete and comparable to older perennial 
foliage 100% 

Entering dormancy, coloration started, some leaves may have dropped from 
stem 50% 

Cured 30% 
 
Shrub Fuel Moisture (30-300%) 
Enter the moisture content of the shrubs fuels. 
 
Foliage Moisture Content (30-200%)  
The foliar moisture content is the percent of moisture in the foliage, needles and leaves.  In 

t at 100% since there are no reliable methods to use current PCHA, this value is held constan
fuels and weather inputs to model its change throughout the year. 
 
20-ft. Wind Speed (0-99mph) 
The wind speed is frequently taken at a National Fire Danger Rating System weather station.  
The National Fire Weathers Observers Handbook provides the standards for the gathering of 
weather at stations designated to provide data for the National Fire Danger Rating System 

eeming et. al, 1972). The wind speed measurement is taken at 20 feet above the vegetation and 
verage.  The wind speed values used should be the average 

(D
is measured based on a 10-minute a
expected values for the projection period.  Enter the 20-foot wind speed in the cell. 
 
Canopy Base Height (1-299 feet) 
For an individual tree, the measurement of the height to the base of the crown can be made.  Th
averaging of these values for all trees in a stand would give an estimate of the level of the stand 
canopy base height.  Frequently, this is a measure of the point where the limbs of the can
start vertically but the

e 

opy 
 number can be skewed by the presence of small trees or occasional live 

mbs.  A more meaningful value would be the height above the ground of the first canopy layer 
where the density of the crown mass within the layer is high enough to support vertical 
movement of a fire.  
 

li
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Canopy Bulk Density (kg/m3) 
Mathematically, canopy bulk density (CBD) (kg/m3) is canopy biomass divided by the volume 
occupied by crown fuels.  Canopy bulk density is hard to estimate in the field.  Initially, it seems 
attractive to calculate this value by treating the canopy as a box with the depth the stand height 
minus the canopy base height.  Assuming this box covered an acre (43,560 ft2), dividing the fuel 
loading in the canopy by the volume of box would provide an estimate of average canopy bulk 
density.  Unfortunately, this estimate has a bias toward underestimation of the canopy bulk 
density due to the averaging of largely void areas in the top and bottom of the canopy with the 
more dense layers of foliage.  A fire burning vertically within the crowns will most likely 
propagate through denser canopy layers. 
 
Stand Height (5-300 feet) 
For an individual tree, the measurement of the tree height made.  The averaging of these values 
for all trees in a stand would give an estimate of the stand height. 
 
Canopy Cover Percentage (0-100%) 
Canopy cover is normally measured as a 
percent.   It is based on the lineal length 
that is within a canopy versus in the 
open.  Frequently, canopy cover values 
are defined via the categories shown in 
Table 31.  

Table 31 – Definition of Canopy Cover Categories 
Category Range Used in Calculations 

0 0% 0% 
1 1 – 20% 10% 
2 21–50% 35% 
3 51-80% 65% 
4 81-100% 90% 

 
Slope (0-100%) 
The slope steepness is expressed in percent and equal to the number of feet of elevation change 
per 100 feet of horizontal distance. The value is the steepness of the slope “straight uphill.”   
 
Midflame Wind Speed 
The midflame wind speed is the wind speed that exists at midflame height above the fuel bed. 
Midflame is often called eye-level. Technically, midflame wind speed is the average wind speed 
measured from the top of the fuel bed to the height of the flame above the fuel (Albini and 
Baughman 1979).  
 
Surface Rate of Spread (ch/hr) 
Rate of spread is the “speed” the fire travels through the surface fuels.  The rate of spread is the 
spread rate of the head fire spreading uphill with the wind blowing straight uphill.  The rate of 
spread prediction uses the Rothermel (1972) surface fire spread model, which assumes the 
weather, topography and fuels remain uniform for the elapsed time of the projection. 
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Surface Flame Length (feet) 
This is the length of the flame in a spreading 
surface

Figure 175 

 fire within the flaming front. Flame length 
 measured from midway in the combustion zone 

e tip of the flames.  “Flame length is 
ye of the 

eholder. It is a poor quantity to use in a scientific 
or engineering sense, but it is so readily apparent 
to fireline personnel and so readily conveys a 
sense of fire intensity that it is worth featuring as a primary fire variable.” (Rothermel 1991) 

is
to the averag
an elusive parameter that exists in the e
b

 
Fire Type  
There as three types of fires predicted. 
 

• Surface Fire 

urface Fire 
that burns only in the surface fuelbed. 

 
d of the fire, but 

e main fire spread is still dependent upon surface fire behavior. 

• Passive Crown Fire 
• Active Crown Fire 

 
S
A surface fire is one 
 
Passive Crown Fire 
A passive crown fire is traditionally called “torching.” It is small scale, consuming single or
small groups of trees or bushes. This stage of a crown fire reinforces the sprea
th
 
Active Crown Fire 
An active crown fire is associated with a "pulsing" spread. The surface fire ignites crowns and 
the fire spread is able to propagate through the canopy. After a distance, the crown fire weakens 
due to a lack of reinforcing surface fire heat. When the surface fire catches up to where the 
crown fire died, the surface fire intensity again initiates a crown fire “pulse.” 
 
Resultant Rate of Spread 
This is the final calculated fire spread rate.  If the fire type is passive then the estimated fire 
spread rate is the same as the surface fire behavior rate of spread.  If the fire type is active, then 
this value is calculated as the crown rate of spread (Rothermel 1991).   If the fire type is passive, 
then this value is scaled between the surface fire spread rate when passive crown starts and the 
maximum crown rate of spread based on the crown fraction burned (Scott and Reinhart 2000). 
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Resultant Flame Length (feet) 
This is the length of the flame based fire intensity.  This intensity is calculated based on the fuel 
consumption in the surface and aerial (canopy) fuels.  The resultant flame length for a surface 
fire type is the same as surface flame length.  For a passive or active crown fire, the resultant 
flame length will be longer due to the consumption of canopy fuels in addition to the surface 
fuels. 
 
Fire Intensity Level Table 32 

Fire Intensity Level Flame Length 
1 0 – 2.0 feet 
2 2.1 – 4.0 feet 
3 4.1 – 6.0 feet 
4 6.1 – 8.0 feet 
5 8.1 – 12.0 feet 
6 12.1+ feet 

For FPA, the Fire Intensity Level (FIL) is defined 
using the flame length.  Table 32 lists the 
correlations between FIL and flame length.  In 
FPA, fire effects are defined by FIL. 

 
 
 
 
Window Figure 176 – The Window Menu 
In PCHA, the user can have multiple windows open 
at the same time. These commands allow the user to 
rearrange these windows. The choices include tiling 
or cascading the windows as well as aligning the 
icons of minimized windows. 
 
Cascade 
This option tells PCHA to stack multiple windows 
one atop another if it is beneficial to have more than 
one window open at a time. 
 
Tile Horizontal 
With the horizontal tile option, PCHA attempts to place windows side by side. This can be useful 
as it allows the user to see information from different screens at the same time. The windows 
tend to be tall and skinny. 
 
Tile Vertical 
Tile vertical puts multiple windows one above another. The windows are short and wide. This 
option works for some windows and is impossible to read for others. 
 
Arrange Icons 
If the user has multiple windows open but minimized, the icons for each minimized window are 
arranged along the bottom of the screen. 
 
NIFMID 
Reserved for later use. 
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The Help Menu Figure 177 – The Help Menu 

 

 
Contents 
Reserved for later use.  
 
About 
This screen displays the version and release date of the software. 
 

 
 
 



 

 Page 118                                                                                                                     PCHA User’s Guide – 10/18/2004 



 

PCHA 1.2 Users’ Guide – 10/18/2004 - Draft Page 119

References 
 
Albini, Frank A. 1976. Computer-based models of wildland fire behavior: a user's manual. 
Ogden, Utah: U.S. Department of Agriculture, Forest Service, Intermountain Forest and Range 
Experiment Station. 68 p. 
 
Albini, Frank A. 1976. Estimating wildfire behavior and effects. General Technical Report 
INT-30. Ogden, Utah: U.S. Department of Agriculture, Forest Service, Intermountain Forest and 
Range Experiment Station. 92 p. 
 
Albini, Frank A.; Baughman, Robert G. 1979. Estimating windspeeds for predicting wildland 
fire behavior.  USDA For. Ser. Res. Paper INT-221.12 p. 
 
Alexander, M. E.  1988.  Help with making crown fire hazard assessments.  In: Protecting people 
and homes from wildfire in the Interior West: Proceedings of the Symposium and Workshop. 
USDA For. Serv. Gen. Tech. Rep. INT-251, pages 147-153. 
 
Anderson, Hal E. 1982. Aids to determining fuel models for estimating fire behavior.  USDA 
For. Serv. Gen. Tech. Rep. INT-122, 20 p. 
Anderson 1982 
 
Bradshaw, Larry S.; Deeming, John E.; Burgan, Robert E.; Cohen, Jack D., compilers. 1984. The 
1978 national fire-danger rating system: technical documentation. General Technical Report 
INT-169. Ogden, Utah: U.S. Department of Agriculture, Forest Service, Intermountain Forest 
and Range Experiment Station. 44 p. 
 
Burgan, Robert E. 1988. Revisions to the 1978 national fire-danger rating system. Research 
Paper SE-273. Asheville, North Carolina: U.S. Department of Agriculture, Forest Service, 
Southeastern Forest Experiment Station. 39 p. 
 
Byram, G. M. 1959. Combustion of forest fuels. In Forest fire control and use, p. 82. Kenneth P. 
Davis, ed. McGraw-Hill Book Co., New York. 
 
Deeming, John E., Burgan, Robert E., and Cohen, Jack D. 1977. The national fire-danger rating 
system-1978. General Technical Report INT-39. Ogden, Utah: U.S. Department of Agriculture, 
Forest Service, Intermountain Forest and Range Experiment Station. 63 p. 
 
Finney, Mark A. 1998. FARSITE: Fire Area Simulator -- model development and evaluation.  
USDA Forest Service, Research Paper RMRS-4, Rocky Mountain Research Station, Ft. Collins, 
CO. 45p. 
 
Furman, R. William; and Brink, Glen E. 1975. The national fire weather data library: what it is 
and how to use it. General Technical Report RM-19. Fort Collins, Colorado: U.S. Department of 
Agriculture, Forest Service, Rocky Mountain Forest Experiment Station. 8 p. 



 

 Page 120                                                                                                                     PCHA User’s Guide – 10/18/2004 

 
Keane, Robert E., Janice L. Garner, Kirsten M. Schmidt, Donald G. Long, James P. Menakis and 
Mark A Finney. 1998. Development og Input Data Layers fort he FARSITE Fire Growth Model 
for the Selway-Bitterroot Wilderness Complex, USA.   USDA For. Serv. Gen.  Tech.  
Rep.RMRS-GTR-3. 66 p. 
 
Main, William A.; Paananen, Donna M., and Burgan, Robert E. 1990. FIREFAMILY 1988. 
General Technical Report NC-138. St. Paul, Minnesota: U.S. Department of Agriculture, Forest 
Service, North Central Forest Experiment Station. 31 p. 
 
Rothermel, Richard C. 1972. A mathematical model for predicting fire spread in wildland fuels. 
Research Paper INT-115. Ogden Utah: U.S. Department of Agriculture, Forest Service, 
Intermountain Forest and Range Experimental Station. 40 p. 
  
Rothermel, Richard C. 1991. Predicting behavior and size of crown fires in the northern Ricky 
Mountains.  USDA For. Serv. Res. Pap. RP-INT-438, 46 p.  
 
Scott, Joe H. and Elizabeth D. Reinhart 2000. Assessing Crown Fire Potential by Linking 
Models of Surface and Crown Fire Behavior.  USDA For. Serv. Res. Pap. RMRS-RP-29, 59 p.  
 
Yancik. Richard F.; and Roussopoulos, Peter J. 1982. User's guide to the national fire occurrence 
data library. Fort Collins, Colorado: U.S. Department of Agriculture, Forest Service, Rocky 
Mountain Forest and Range Experiment Station. 25 p. 
 
US Forest Service, 1995. KCFAST user's guide. Boise, Idaho: U.S. Department of Agriculture, 
Forest Service, Fire and Aviation Management Staff. 156 p. 
 
US Forest Service, 1995. Weather information management system (WIMS) user's guide. Boise, 
Idaho: U. S. Department of Agriculture, Forest Service, Fire and Aviation Management Staff. 
80+ p. 
 
Van Wagner, C. E. 1977.  Conditions for the start and spread of crown fire.  Canadian Journal of 
Forest Research 7:23-34. 
 
Van Wagner, C. E. 1993.  Prediction of crown fire behavior in two stands of jack pine.  Canadian 
Journal of Forest Research 23:442-449 
 
 

 



 

PCHA 1.2 Users’ Guide – 10/18/2004 - Draft Page 121

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Appendix A 
 

Forest Service PCHA Report Format 
 



 

 Page 122                                                                                                                     PCHA User’s Guide – 10/18/2004 

 

 Page 122                                                                                                                     PCHA User’s Guide – 10/18/2004 

 



 

PCHA 1.2 Users’ Guide – 10/18/2004 - Draft Page 123

Forest Service PCHA Report Format 
 
File names look like (PCHArrff.RAW) where rrff are the FS region and forest identified on the 
Planning Unit Setup screen. The file extension must be RAW. 
 

Table 30 
Item 
No. Field Name Field Width Example 

1 Reporting FS Region 1-2 5 
2 Reporting FS Unit 3-4 16 
3 Fire Number 5-7 23 
4 District 8-9 52 
5 Statistical Cause 10 1 
6 General Cause 11 0 
7 Specific Cause 12-13 1 
8 Class of People 14 0 
9 Fire Size Class 15 B 
10 Total Acres Burned 16-24 0.3 
11 FS Area Burned 25-33 0.2 
12 Non-FS, FS Prot Acres Burned 34-42 0.1 
13 Non-FS Acres Burned 43-51 0 
14 Vegetation Cover Type 52-53  
15 NFMAS Aspect 54  
16 Topography Code 55  
17 Fire Management Zone (60 usually blank) 56-60  
18 Weather Station 61-66 41523 
19 NFDRS Fuel Model 67 G 
20 Fire Intensity Level (FIL) 68 2 
21 Fire Intensity Source 69-70 FR 
22 Latitude (DDMMSS) 71-76 360200 
23 Longitude (DDMMSS) 77-83 1190612 
24 Township 84-88  
25 Range 89-93  
26 Section 94-95  
27 Subsection 96-99  
28 Principal Meridian 100-101  
29 Slope Percent 102-104  
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Table 30 
Item 
No. Field Name Field Width Example 

30 Aspect Code 105  
31 Elevation 106-110  
32 State 111-112 CA 
33 County 113-115  
34 Protection Agency 116-118  
35 Ownership at Origin 119  
36 Prescribed Fire 120 Y/N 
37 Escaped Fire 121 Y/N 
38 Initial Suppression Strategy 122  
39 Fire Cost in Dollars 123-131  
40 Ignition Date 132-139  
41 Ignition Time 140-143  
42 Discovery Date 144-151 19900714 
43 Discovery Time 152-155  
44 First Action Date 156-163  
45 First Action Time 164-167  
46 Second Action Date 168-175  
47 Second Action Time 176-179  
48 Declared Wildfire Date 180-187  
49 Declared Wildfire Time 188-191  
50 Fire Contained Date 192-199  
51 Fire Contained Time 200-203  
52 Fire Controlled Date 204-211  
53 Fire Controlled Time 212-215  
54 Fire Out Date 216-223  
55 Fire Out Time 224-227  
56 Fire Name 228-247 Lost Loop 
57 Fire ID 248-254  
58 Fire Account (PCode) 255-259  
59 Wilderness 260-262  
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Appendix B 
 

Department of Interior DI-1202 Format 
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File names on the FAMWEB site look like flnfmas2!rrff!1950!2002.raw. where rrff are the FS 
region and forest identified on the Planning Unit Setup screen. The file extension must be RAW. 
 
 Table 31 – DI-1202 Fire Record Format 

Item 
No. Item Width Start

Col. 
Stop
Col. 

Number 
of 

Decimals 
Type 

1 UNIT ID 8 1 8  CHARACTER
2 CALENDAR YEAR 4 10 13  NUMERIC 
3 FIRE NUMBER 4 15 18  CHARACTER
4 FIRE TYPE 2 20 21  NUMERIC 
5 GENERAL CAUSE 1 23 23  NUMERIC 
6 SPECIFIC CAUSE 2 25 26  NUMERIC 
7 PEOPLE 1 28 28  CHARACTER
8 NET CHANGE 8 30 37  CHARACTER
9 FIRE NAME 10 39 48  CHARACTER
10 AREA NAME 4 50 53  CHARACTER
11 LATITUDE 6 55 60  NUMERIC 
12 LONGITUDE 7 62 68  NUMERIC 
13 COST CODE 1 70 70  NUMERIC 
14 OWNER 1 72 72  NUMERIC 
15 FISCAL YEAR 2 74 75  NUMERIC 
16 AGENCY FISCAL DATA 1 11 77 87  NUMERIC 
17 AGENCY FISCAL DATA 2 11 89 99  NUMERIC 
18 PROBLEM CLASS 1 101 101  CHARACTER
19 TOWNSHIP 4 103 106  CHARACTER
20 RANGE 4 108 111  CHARACTER
21 SECTION 2 113 114  CHARACTER
22 MERIDIAN 2 116 117  CHARACTER
23 UTM ZONE 2 119 120  CHARACTER
24 UTM EASTERN 6 122 127 2 NUMERIC 
25 UTM NORTHERN 7 129 135 2 NUMERIC 
26 DATE DISCOVERED 6 137 142  NUMERIC 
27 TIME DISCOVERED 4 144 147  NUMERIC 
28 TYPE DISCOVERED 1 149 149  CHARACTER
29 ACRES DISCOVERED 7 151 157 1 NUMERIC 
30 DATE INIT ATTACK 6 159 164  NUMERIC 
31 TIME INIT ATTACK 4 166 169  NUMERIC 
32 TYPE INIT ATTACK 1 1 171 171  CHARACTER
33 TYPE INIT ATTACK 2 1 173 173  CHARACTER
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 Table 31 – DI-1202 Fire Record Format 

Item 
No. Item Width Start

Col. 
Stop
Col. 

Number 
of 

Decimals 
Type 

34 TYPE INIT ATTACK 3 1 175 175  CHARACTER
35 TYPE INIT ATTACK 4 1 177 177  CHARACTER
36 TYPE INIT ATTACK 5 1 179 179  CHARACTER
37 AMOUNT INIT ATTACK 1 2 181 182  NUMERIC 
38 AMOUNT INIT ATTACK 2 2 184 185  NUMERIC 
39 AMOUNT INIT ATTACK 3 2 187 188  NUMERIC 
40 AMOUNT INIT ATTACK 4 2 190 191  NUMERIC 
41 AMOUNT INIT ATTACK 5 2 193 194  NUMERIC 
42 ACRES INIT ATTACK 7 196 202 1 NUMERIC 
43 DATE CONTROLLED 6 204 209  NUMERIC 
44 TIME CONTROLLED 4 211 214  NUMERIC 
45 ACRES CONTROLLED 7 216 222 1 NUMERIC 
46 DATE DECLARED OUT 6 224 229  NUMERIC 
47 TOPOGRAPHY 1 231 231  NUMERIC 
48 ASPECT 1 233 233  CHARACTER
49 SLOPE 1 235 235  NUMERIC 
50 ELEVATION 1 237 237  CHARACTER
51 NFDRS STATION 6 239 244  NUMERIC 
52 NFDRS FUEL STATION 4 246 249  CHARACTER
53 BEHAVIOR 1 251 251  NUMERIC 
54 BURN INDEX 3 253 255  NUMERIC 
55 ADJ CLASS 1 257 257  NUMERIC 
56 RVC 1 259 259  CHARACTER
57 FORM OF HEAT 2 261 262  CHARACTER
58 CERTAINTY 1 264 264  NUMERIC 
59 EQUIPMENT INVOLVED 3 266 268  NUMERIC 
60 MATERIAL INVOLVED 2 270 271  CHARACTER
61 IGNITION FACTOR 2 273 274  CHARACTER
62 CLASS PEOPLE 1 276 276  CHARACTER
63 AGE 1 278 278  CHARACTER
64 SEX 1 280 280  CHARACTER
65 ACTIVITY INVOLVED 2 282 283  CHARACTER
66 ESTIMATED DAMAGE 7 285 291  NUMERIC 
67 STATE 2 293 294  CHARACTER
68 LAND OWNER 1 296 296  NUMERIC 
69 REF FIRE NBR 4 298 301  CHARACTER
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 Table 31 – DI-1202 Fire Record Format 

Item 
No. Item Width Start

Col. 
Stop
Col. 

Number 
of 

Decimals 
Type 

70 VEG. TYPE 1 303 303  NUMERIC 
71 ACRES 7 305 311 1 NUMERIC 
72 STATE 2 313 314  CHARACTER
73 LAND OWNER 1 316 316  NUMERIC 
74 REF FIRE NBR 4 318 321  CHARACTER
75 VEG. TYPE 1 323 323  NUMERIC 
76 ACRES 7 325 331 1 NUMERIC 
77 STATE 2 333 334  CHARACTER
78 LAND OWNER 1 336 336  NUMERIC 
79 REF FIRE NBR 4 338 341  CHARACTER
80 VEG. TYPE 1 343 343  NUMERIC 
81 ACRES 7 345 351 1 NUMERIC 
82 STATE 2 353 354  CHARACTER
83 LAND OWNER 1 356 356  NUMERIC 
84 REF FIRE NBR 4 358 361  CHARACTER
85 VEG. TYPE 1 363 363  NUMERIC 
86 ACRES 7 365 371 1 NUMERIC 
87 STATE 2 373 374  CHARACTER
88 LAND OWNER 1 376 376  NUMERIC 
89 REF FIRE NBR 4 378 381  CHARACTER
90 VEG. TYPE 1 383 383  NUMERIC 
91 ACRES 7 385 391 1 NUMERIC 
92 STATE 2 393 394  CHARACTER
93 LAND OWNER 1 396 396  NUMERIC 
94 REF FIRE NBR 4 398 401  CHARACTER
95 VEG. TYPE 1 403 403  NUMERIC 
96 ACRES 7 405 411 1 NUMERIC 
97 STATE 2 413 414  CHARACTER
98 LAND OWNER 1 416 416  NUMERIC 
99 REF FIRE NBR 4 418 421  CHARACTER
100 VEG. TYPE 1 423 423  NUMERIC 
101 ACRES 7 425 431 1 NUMERIC 
102 STATE 2 433 434  CHARACTER
103 LAND OWNER 1 436 436  NUMERIC 
104 REF FIRE NBR 4 438 441  CHARACTER
105 VEG. TYPE 1 443 443  NUMERIC 
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 Table 31 – DI-1202 Fire Record Format 

Item 
No. Item Width Start

Col. 
Stop
Col. 

Number 
of 

Decimals 
Type 

106 ACRES 7 445 451 1 NUMERIC 
107 UNIT NUMBERS 2 453 454  CHARACTER
108 PLOT NUMBER 2 456 457  CHARACTER
109 PLOT OBJECTIVE 2 459 460  NUMERIC 
110 FIRING STRATEGY 1 462 462  NUMERIC 
111 FIRING METHOD 1 464 464  NUMERIC 
112 COST PER ACRE 4 466 469 2 NUMERIC 
113 NFFL FUEL MODEL 2 471 472  NUMERIC 
114 TEMP MAX 3 474 476  NUMERIC 
115 TEMP MIN 2 478 479  NUMERIC 
116 REL. HUMIDITY MAX 2 481 482   
117 REL. HUMIDITY MIN 2 484 485 NUM ERIC 
118 WIND MAX 2 487 488  NUMERIC 
119 WIND MIN 2 490 491  NUMERIC 
120 FLAME MAX 3 493 495  NUMERIC 
121 FLAME MIN 2 497 498  NUMERIC 
122 ROS MAX 3 500 502  NUMERIC 
123 ROS MIN 2 504 505  NUMERIC 
124 NFFL FUEL MODEL 2 507 508  NUMERIC 
125 TEMP MAX 3 510 512  NUMERIC 
126 TEMP MIN 2 514 515  NUMERIC 
127 REL. HUMIDITY MAX 2 517 518  NUMERIC 
128 REL. HUMIDITY MIN 2 520 521  NUMERIC 
129 WIND MAX 2 523 524  NUMERIC 
130 WIND MIN 2 526 527  NUMERIC 
131 FLAME MAX 3 529 531  NUMERIC 
132 FLAME MIN 2 533 534  NUMERIC 
133 ROS MAX 3 536 538  NUMERIC 
134 ROS MIN 2 540 541  NUMERIC 
135 PREBURN TONS/ACRE 3 543 545 1 NUMERIC 
136 CONSUMPTION % 3 547 549  NUMERIC 
137 PREBURN TONS/ACRE 3 551 553 1 NUMERIC 
138 CONSUMPTION % 3 555 557  NUMERIC 
139 PREBURN TONS/ACRE 3 559 561 1 NUMERIC 
140 CONSUMPTION % 3 563 565  NUMERIC 
141 PREBURN TONS/ACRE 3 567 569 1 NUMERIC 
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 Table 31 – DI-1202 Fire Record Format 

Item 
No. Item Width Start

Col. 
Stop
Col. 

Number 
of 

Decimals 
Type 

142 CONSUMPTION % 3 571 573  NUMERIC 
143 PREBURN TONS/ACRE 3 575 577 1 NUMERIC 
144 CONSUMPTION % 3 579 581  NUMERIC 
145 PREBURN TONS/ACRE 3 583 585 1 NUMERIC 
146 CONSUMPTION % 3 587 589  NUMERIC 
147 FIRE ESCAPE  591 590 1 CHARACTER
148 ESCAPE FIRE NUMBER 3 592 594 1 CHARACTER
149 DAY OF WEEK STARTED 1 596 596  CHARACTER
150 WAS FIRE INVESTIGATED 1 598 598  CHARACTER
151 WAS SUSPECT KNOWN 1 600 600  CHARACTER
152 TYPE OF SUSPECT 1 602 602  CHARACTER
153 REF PROJECT NUMBER 6 604 609  CHARACTER
154 PNF COMPLEX ESCAPE 1 611 611  CHARACTER
155 PNF COMPLEX VALUES 1 613 613  CHARACTER
156 PNF COMPLEX FUELS 615 CHARACTER1 615  
157 PNF COMPLEX DURATION 1 617 617  CHARACTER
158 PNF COMPLEX AIR QUALITY 1 619 619  CHARACTER
159 SUBMITTED NAME 30 621 650  CHARACTER
160 SUBMITTED TITLE 30 652 681  CHARACTER
161 SUBMITTED DATE 6 683 688  NUMERIC 
162 690 CHARACTERAPPROVED NAME 30 719  
163 APPROVED TITLE 30 721 750  CHARACTER
164 APPROVED DATE 6 752 757  NUMERIC 
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Appendix C 
 

Weather .fwx File Format 
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This file is also known as a "short obs" file. Weather observations must use the naming 
convention (WXnnnnnn.FWX) where nnnnnn is the weather station number. The prefix letters 
WX are optional. The file extension must be FWX. 
 

Table 32 – Weather fwx File Format 
Item 
No. Item Column 

Width 
1 Weather Station Number 1-6 
2 Observation Date (YYMMDD) 7-12 
3 State of Weather Code 13 
4 Dry Bulb Temperature 14-16 
5 Relative Humidity (Percent) 17-19 
6 blank 20-22 
7 Herbaceous Vegetation Condition 23-24 
8 Human-caused Risk 25-27 
9 28 Wind Direction 
10 Wind speed (mph) 29-31 
11 blank 32 
12 10-Hour timelag fuel moisture 33-35 
13 blank 36-38 
14 Maximum temperature (1F) 39-41 
15 Minimum temperature (1F) 42-44 
16 Maximum relative humidity (percent) 45-47 
17 Minimum relative humidity (percent) 48-50 
18 blank 51 
19 Precipitation duration (hours) 52-53 
20 Precipitation amount (inches nn.nn) 54-57 
21 Lightning Activity Level 58-60 
22 RH indicator (2) 61 
23 blank 62-80 
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Appendix D 
 

Weather Observation Data Transfer Format 1998 (.fw9) 
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Weather Observation Data Transfer Format 1998 (.fw9) 

New data format adopted in May of 1998 intended to replace the Short weather observation file 
format.(.FWX). This format attempts to meet current and future needs and to remedy the 
shortcomings of the 1972 format. 

Table 33 – Weather .fw9 File Format 
Item 
No. Item Column 

Width 

1 Record type (W98). All records begin with this record type identifier 
code 01-03 

2 Station Number 04-09 
3 Observation date (YYYYMMDD) 10-17 
4 18-21 Observation time (0000-2359) 

5 Observation type (O=NFDRS, R=Raws other than at the standard 
NFDRS observation time, F=Forecast, X=Other) 22 

6 State of weather code 23 

7 Dry bulb temperature (degrees Fahrenheit or degrees Celsius based on 
Measurement Type code 24-26 

8 Atmospheric moisture (wet bulb temperature, relative humidity 
(percent), or dew point temperature based on Moisture Type code 27-29 

9 Wind direction azimuth measured from true north; 0 (zero) means no 
wind direction, 360 is north 30-32 

10 Average wind speed over a ten-minute period (miles or kilometers per 
hour based on Measurement Type code 33-35 

11 Measured 10-hour time lag fuel moisture 36-37 

12 Maximum Temperature (degrees Fahrenheit or degrees Celsius base on 
Measurement Type code 38-40 

13 Minimum Temperature (degrees Fahrenheit or degrees Celsius base on 
Measurement Type code 41-43 

14 Maximum relative humidity (percent) 44-46 
15 Minimum relative humidity (percent) 47-49 
16 Precipitation duration (hours) 50-51 

17 52-56 

Precipitation amount based on Measurement Type code [col. 63]. 
Blanks=no precipitation. US measurement: inches with implied decimal 
nn.nnn format; trace shown as 00005. Metric measurement: in 
millimeters, no implied decimal; trace shown as 00001 

18 Wet flag (Y/N) 57 
19 Herbaceous greenness factor (0-20) 58-59 
20 Shrub greenness factor (0-20) 60-61 
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Table 33 – Weather .fw9 File Format 
Item 
No. Item Column 

Width 
21 Moisture Type code (1=Wet Bulb, 2=Relative humidity,3=Dew point) 62 

22 
Measurement Type code (1=U.S., 2=Metric, Affects temperature 
(Fahrenheit or Celsius), wind (miles or kilometers per hour), and 
precipitation (decimal inches or millimeters)) 

63 

23 Season code (1=Winter, 2=Spring, 3=Summer, 4=Fall) 64 

24 Solar radiation (watts per square meter) 65-68 
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Appendix E 
 

GIS Formats 
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The format for the GIS 1 file is in Table 34. 
GIS 1 

 
Table 34 
Item 
No. Item Field 

Type Example

1 PCHA ID N 23 
2 PCHA latitude N 35.1225
3 PCHA longitude N 118.334

 
 

GIS 2 
GIS type 2 output uses the naming convention (GISxxxxx.xxx) where xxxxx is .... Fields are 
comma delimited (separated by a comma) in the order listed below. Alpha fields (A) are 
enclosed within quotes (“”). 
 

Table 35 
Item 
No. Item Field 

Type Example

1 PCHA ID N 23 
2 Fire number A 49 
3 Fire name A Lost Loop
4 Discovery date D 7/4/1985
5 Discovery year N 1985 
6 Discovery month N 7 
7 Discovery day in month N 4 
8 Julian day number N 185 
9 Weekday N 3 
10 PCHA latitude N 35.1225
11 PCHA longitude N 118.334
12 Statistical cause N 1 
13 Total acres burned N 0.3 
14 FMZ A 0A 
15 N Representative location 1 
16 NFDRS fuel model A G 
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